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Instruction Manual

Content of this Instruction Manual

DPP stands for Digital Photo Professional.

In this manual, the screens used in the basic
operation instructions are from Windows 8.1.

» indicates the selection procedure of the menu.

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.

Click to move to the relevant page.

indicates the function for advanced

users who are experienced in handling image

processing software.

"2 : Marks helpful information when a problem
arises.

-
~

/T

: Marks tips for using the software skillfully.

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

AN/

=ING)

Switching Between Pages

Click on arrows on the bottom right of the screen.
@ : next page
@ : previous page
: return to a page you had previously

displayed
Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.
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Introduction

Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

* indicates processing that can be performed with JPEG or
TIFF images as well as RAW images.

View and organize images
Play back movies and save still photos

Adjust an image
Various image adjustments while maintaining the original image

Freely apply a Picture Style
View your image before and after adjustment in the same window

Trim and adjust the angle of an image

(trimming)

Resize an image
Correction of lens aberration
Digital Lens Optimizer

Automatic/manual dust erasure processing

JPEG/TIFF

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print an image
Link with EOS Utility for remote shooting

JPEG/TIFF

Color management compatibility
CMYK simulation for commercial printing

@ In DPP Ver. 4.8.20 or later, clicking [Check for updates] in the [Help]

menu allows you to check for update files on the server and
download any update files that are available.

To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required. Internet Service Provider (ISP) connection fees or access
point connection fees may apply.
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System Requirements

OS (operating

Windows 10 (Version 1607 or later)*, Windows 8.1%,

system) Windows 7*

Model PC with one of the above OS preinstalled
(Upgraded machines not supported)

CPU Core 2 Duo 2.0 GHz or higher (recommended Core i
series or later)

RAM 2.0 GB or more of RAM (4.0 GB or more

(memory) recommended)

Hard disk Installation: Min. 300 MB of available space

drive Operation: Min. 600 MB of available space
Resolution: XGA (1024 x 720) or more (1600 x 1200

Display or more recommended)

Colors: 16-bit color (65536 colors) or more

* May also be installed on a 32-bit version PC, but with restrictions on
operation. On 32-bit OSs, (32bit) is displayed on the [About Digital
Photo Professional 4] in [Help]. For information on restrictions, see
descriptions indicated with in this manual.

* In DPP, to play back MOV or MP4 movies shot using a supported
camera, and to save still photos from movies, a 64-bit version of
Windows 8.1 or later is required.

*With Microsoft .NET Framework 4.7.1 or later installed

For information on system requirements for HDR PQ mode

(including supported images), see “System Requirements for
HDR PQ Mode” (p.144).

For images supported by depth compositing, see “Using Depth
Compositing” » “Supported Images” (p.115).

Supported Cameras

EOS-1D X Mark II, EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds
Mark Ill, EOS-1D Mark Ill, EOS-1D Mark Il N, EOS-1Ds Mark II,
EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5DS/EOS 5DS R, EOS 5D
Mark IV, EOS 5D Mark Ill, EOS 5D Mark Il, EOS 5D, EOS 6D Mark II,
EOS 6D, EOS 7D Mark Il, EOS 7D, EOS 80D, EOS 70D, EOS 60D/
EOS 60Da, EOS 50D, EOS 40D, EOS 30D, EOS 20D/EQOS 20Da, EOS
10D, EOS D2000, EOS D30, EOS D60, EOS 77D, EOS 760D, EOS
800D, EOS 750D, EOS 700D, EOS 250D, EOS 200D, EOS 100D, EOS
2000D, EOS 1300D, EOS 1200D, EOS 650D, EOS 600D, EOS 550D,
EOS 500D, EOS 450D, EOS 1000D, EOS 1100D, EOS 400D, EOS
350D, EOS 4000D, EOS 300D, EOS R, EOS RP, EOS M6, EOS M5,
EOS M3, EOS M2, EOS M, EOS M10, EOS M100, EOS M50,
PowerShot G3 X ', PowerShot G1 X Mark II'", PowerShot G7 X 7,
PowerShot G9 X ', PowerShot SX60 HS™', PowerShot G5 X ',
PowerShot G7 X Mark II*1, PowerShot G16*1, PowerShot 8120*1,
PowerShot G1 X !, PowerShot G15 ', PowerShot $110™",
PowerShot S100™", PowerShot G9 X Mark II'!, PowerShot G1 X
Mark 111", PowerShot G9'"2, PowerShot G102, PowerShot G112,
PowerShot G12 12, PowerShot S90 12, PowerShot S95 2,
PowerShot SX1 1S 12, PowerShot SX50 HS "2, and PowerShot
SX70 HS™12
*1 For RAW images, functions that are not in the camera (such as the
Auto Lighting Optimizer) and functions such as the Digital Lens
Optimizer cannot be used. However, Picture Styles, even if not in the
camera, can be used with the exception of some functionality.
*2 The following functions are unavailable.
- Basic Adjustment tool palette:
White balance [Fine-tune]
A portion of [Gamma adjustment]
Automatic gradation and luminance adjustment
Midpoint adjustment
Input white points range expansion
- Dust Delete/Copy Stamp tool palette
- Compositing tool
- HDR tool
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Supported Images

Image data
Image type Extension
.CR3
RAW | Images in the Canon RAW format .CR2
images | shot on supported cameras® .TIF
il .CRW
photos | JPEG | Exif 2.2, 2.21 or 2.3-compatible JPEG
images | images JPG/.JPEG
TIFF | Exif-compatible TIFF images TIF/.TIFF
images P 9 : :
Movies Movies shot with supported cameras mg‘\(

* Compatible with RAW images shot with EOS D2000 that have been
converted to RAW images using the CR2 Converter and have the

".CR2" extension.
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* Sections with and in “4 Editing Images”
support not only RAW image editing but also JPEG/TIFF image editing.

: All the functions explained in the section support
JPEG/TIFF image editing.

: Certain functions explained in the section support
JPEG/TIFF image editing.
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Downloading Images

Downloading Images Using Your Card Reader

Starting Up DPP ...,

Downloading Images to Your Computer..................
Downloading Images Using the Software “EOS Utility".......
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Starting up DPP

Double-click the desktop icon.

T

This PC

A

-

Network

Double-click

Professional 4

DPP starts up and the main window (thumbnail layout) appears.

v

Main window (thumbnail layout)

@ If you drop a DPP-supported image file onto the icon on the
desktop, you can start up DPP and display the folder where the
image file is saved.
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Downloading Images to Your Computer " Contents

Download the images saved on the memory card inserted in the < -
camera. Downloading Images Using Your Card Reader Dow qa ding
You can also download images to the computer using a third-party card Images

reader.

Downloading Images Using the Software “EOS Utility”

You can download images with “EOS Utility”, communication software Load the memory card into the card reader.
for the camera. Start up DPP beforehand.

For detailed instructions on downloading images, refer to the “EOS -
Utility Instruction Manual” (PDF electronic manual). Open [My Computer] » [EOS_DIGITAL] and drag the ?n?;tégg
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D Viewing Images

Viewing Images in the Main Window (Thumbnail Layout) ........... 13
Changing the Thumbnail Display............ccccccvvvvvvvnnnnes 14
Using the Thumbnails Control Panel ........ 15
Using the Thumbnail Display Filter/Sort
FUNCLON ... 16
Displaying the Histogram Palette.............. 17
Enlarging and Viewing an Image in the Preview Window............. 18
Enlarging and Viewing a Specific Area...................... 19
Displaying the Navigator Palette................ 19
Checking the Image in Detail ...................... 20
Displaying the Main Window (Multi-layout)................. 20
Checking an Image Using the Preview Control Panel......... 21
Changing the Magnification ..............cccccccvvveeeeenn.... 21
Comparing with a Pinned (Fixed) Image ................ 21
Displaying Multiple Images at the Same Time ....... 22
Displaying Grid Lines............coooiiiiiiiiiiiiiieeeee s 22
Displaying AF Points ..........ccoocciiiiiiiiiieeee e, 22
Displaying Areas Beyond the Set Range with Warning
Indicators (Highlight/Shadow Warning) .................. 23
Comparing Pre- and Post-Editing Images (Single-
Image Display).....ccceeeeeiiiiiiieiiiieeeeeeeee e 23

Comparing Pre- and Post-Editing Images (before/after
comparison) Arrange vertically/horizontally (two-
screen display) / Split vertically/horizontally (split-

image diSplay) ....ccouueeieieiieee e 24
Displaying Image Properties...........ccccceveeeeeeeiinennnn. 24
Checking an Image in Multi-Function Preview ........... 25
Checking an Image in Second Windows.................... 26

Opening and Closing Window Panels (Panes)........ 27

Changing the Display Method and Order of Palettes ....... 28
Changing the Display Method (Dock/Float) of Palettes....... 28
Rearranging Palettes.............cccoiiiiiiiii 28

EXiting DPP ..o 29
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Viewing Images in the Main Window (Thumbnail Layout)

Images downloaded to your computer are displayed as a thumbnails list
in the main window (thumbnail layout). You can double-click an image to
open the preview window (p.18) and display the image at large size.

Main window

Check marks (p.33, p.34)

Ratings (p.33, p.34)
For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.161).

Toolbar

Forward/Reverse

Rotate image

® On 32-bit OSs, up to only 1000 images can be displayed per

5

folder. Starting with the 1001st image, images are handled in the
same way as non-supported images. Try to maintain 1000 images
or less per folder.

For information on movie files, see “Playing Back Movies and
Saving Still Photos” (p.140).

When aspect ratio information is attached to an image shot with
any supported camera other than the EOS 5D Mark Il, the image
is displayed as a cropped image (p.70).

In the main window, in addition to this view (thumbnail layout),
you can select multi-layout. Multi-layout allows you to check the
image in detail (p.20).
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Changing the Thumbnail Display

You can change the size of the thumbnail images displayed in the main
window and select the information displayed for thumbnails.

Select the [Thumbnails] menu P desired item.

Thumbnails

Open preview screen Ctrl+0

¥ | Thumbnail control panel  Ctrl+ Alt+ N

Pin Alt+0

Apply display filter
Sort 3
Group RAW and JPG versions

v Display split files as one thumbnail

Hide file name
+ | Default
With shooting info

List view

A
Size 1 (84=84) Ctrl+1
Size 2 (126:126) Ctrl+2
+ | Size 3 (168:x168) Ctrl+3
Size 4 (2522 252) Ctrl+4
Size 5 (384x384) Ctrl+5
Size 6 (512x512) Ctrl+6
AF points Ctrl+)

The display changes to the selected item.

Introduction/
Contents

y

Downloading
Images

Sorting
Images

Editing
Images

|

Printing
Images
—
Processing

Large Numbers
of RAW Images

Remote
Shooting

—

Playing Back
Movies and Saving

Still Photos

HDR PQ
Mode

Specifying
Preferences

N —

Q0



Using the Thumbnails Control Panel
The thumbnails control panel integrates various settings for viewing thumbnails.
By using this panel, you can view and specify the settings for thumbnails efficiently.

Thumbnails control panel functions

(1)
(2)
)
(4)
®)
(6)
(7)

(1) () 3) (4)

(6) 6) (7)

(8) 9) (10)

Sl 2 lCH Change the size of thumbnails
uDispIay thumbnails without file names
EDispIay standard thumbnails

E Display thumbnails with information
EDispIay thumbnails in list

HSpecify properties display settings (p.157)

Display a RAW image and JPEG image as a single image
Display a RAW image and JPEG image that were shot together
as a single image. When this setting is specified, viewing and
editing of images are as follows.

* Image displayed: Only the RAW image is displayed in all
windows.

+ Edited image: The content which has been edited with any of
DPP’s functions (the tool palette etc.) will be applied to the
RAW image only. However, if you have used the following
functions, the adjustments will be applied to both the RAW
image and the JPEG image.

Deleting an image (p.39)

Moving or copying an image (p.39)
Checkmarking (p.33 to p.34)
Rating (p.33 to p.34)

Rotating an image (p.13)

(8) Display or play back split movie files as single movies

When you play back split movie files in DPP, this setting plays
back all the movie files in a continuous sequence from the
beginning.

This is set to ON by default.

Only the thumbnail for the first movie file is displayed.

This setting will be kept and applied the next time DPP is
started up.

When the following functions are used, they apply to all the
remaining split movie files, not just the first movie file:
[Copy], [Cut], [Delete], [Add to collection], [Rename Tool]
When the Filter/Sort function (p.16) is used with thumbnails,
the function is only applied to the first movie file.

9) ESeIect all thumbnails

(10)

Cancel all thumbnail selections

The thumbnails control panel is displayed in the main window by
default. If it is not displayed, such as when screen settings have
been changed, you can display it by selecting [Thumbnail control
panel] in the [Thumbnails] menu.

In multi-layout (vertical thumbnails, p.20), only the thumbnail view
setting (Default thumbnail display) is possible.
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Using the Thumbnail Display Filter/Sort

Function

This function allows you to display only thumbnails that match the
selected filtering option or to specify an option for sorting thumbnails.

Set the [Filter] button on the [Filter/Sort pane] in the
main window to [ON].

Filter y Sort by File name

Specify settings.
(1) () (3) (4)

Filter ON o'
Shooting Date/Time ¥ Camera

1N ~ Y

Filter menu (2)

Drag to adjust display area of filter

Filter menu list menu lists upward or downward

You can drag the bottom edge of the [Filter/Sort pane] to adjust
the display area of the filter menu lists upward or downward.

(1) Thumbnail display filter ON/OFF
By setting to [ON], only thumbnails matching the filtering option set
with (2) the filtering options menu are displayed.

(2) Filtering options menu

Select a filtering option for the thumbnail display filter.

* After selecting a filtering item in the list box that appears by clicking
[¥] at the right on the filter menu, options appear in the filter menu
list. Select an option.

* You can select multiple options in the filter menu list.

(Hold down the <Shift> key and left-click with the mouse for
consecutive selection. Hold down the <Ctrl> key and left-click with
the mouse to select individually.)

* The filter menus/filter menu lists are prioritized from left to right.
You can specify filtering options from left to right to narrow down
filtering.

(3) Sorting options
Select an option for sorting thumbnails. If files were added, a “*” is

temporarily displayed after the option name. [Custom] is displayed if
you sorted thumbnails in a chosen way.

“wky

(4) Sort order selection
Select the order (ascending/descending) for sorting thumbnails.

(5) Filter lock button
When the filter lock button is clicked, filter settings will be kept and
applied when you switch to a different folder or the next time DPP is
started up. When the filter lock button is not clicked, filter settings
automatically change to [OFF] when you switch to a different folder
or the next time DPP is started up.

@ In addition to thumbnail display, this function can also be used in
multi-layout.
You can open/close the panel by clicking the [¥] button at the
upper right of the [Filter/Sort pane].
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Displaying the Histogram Palette

The histogram palette shows a histogram of the selected image. You
can quickly check a histogram without opening a tool palette.

Select the [View] menu » [Histogram palette].
The histogram palette appears.

You can select any of the following four histograms from the
menu that appears when you right-click with the mouse.
[Brightness only], [RGB separately], [YRGB separately], [RGB
together]

You can click the [] button at the bottom right of the main
window to show/hide the [Histogram] palette.
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Enlarging and Viewing an Image in the Preview Window

® 4 - [Folder: C

Double-click

Tew Bg T
The preview window appears.
Up to 36 windows can be displayed at the same time for the
preview window.
([82bit] On 32-bit OSs, up to 4 windows can be displayed at the
same time.)

Preview window '

Tool palette

Click the [E]] in the upper right of the preview window to close
the preview window.

@ By selecting the [Preview] menu P [AF points] in the preview
window, you can display the AF points selected in the camera at
the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.93), images for which you selected an
effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction or
chromatic aberration correction.
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Enlarging and Viewing a Specific Area

Click the area you want to enlarge.

The area you clicked is enlarged to 100% (actual pixel size).
Click again to revert to the full view.
To change the display area drag on the image.

5\@/5 To display an image in an enlargement ratio other than 100%

Select any enlargement ratio from the [Preview] menu.

@ While in the preview window, you can select the [Preview] menu »
[Preview control panel] to use various preview functions. For details,
see “Checking an Image Using the Preview Control Panel” (p.21).

Displaying the Navigator Palette

The navigator palette shows the enlargement area of a selected image.

Select the [View] menu » [Navigator palette].
The navigator palette appears.

Mavigator

1 T

When an image is enlarged in the preview or other window, the
enlargement display area is indicated in the navigator palette.
The area to be enlarged can be changed by dragging the
enlargement display area on the image.

Mavigator

r

Change the enlargement
display area by dragging

5 a
N
L T

o il |

You can click the [[E]] button at the bottom right of the main
window to show/hide the [Navigator] palette.
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Checking the Image in Detail

Displaying the Main Window (Multi-layout)

By switching the main window to “multi-layout”, you can use the preview control panel to check the image in detail.

Click a change layout button at the bottom of the main window (thumbnail layout).
The main window (multi-layout) appears.
In the main window (multi-layout), you can select from two layouts, with horizontal thumbnails or vertical thumbnails.
Click the area you want to enlarge in the image displayed in the preview display area to display the image at actual pixel size (100%). Click the
image again to revert to full display.

Main Window (thumbnail layout) Multi-layout (horizontal thumbnails)

. SFLE < Preview
- ‘l'fﬁ h UL display area

o il | B W et

display area

ij j . Thumbnail

Layout change button

A

o v il B et

Horizontal thumbnails

Vertical thumbnails
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Checking an Image Using the Preview Control Panel

With Preview control panel, you can check the image in detail.

You can use this panel in the main window (multi-layout) and edit image
window. If the preview control panel is not displayed, you can display it
by selecting [Preview control panel] from the [Preview] menu. By
default, the [[E]]] button and [] button are selected. When you select a
movie, the displayed content changes. For information on the display
when movies are selected, see “Playing Back Movies and Saving Still
Photos” (p.140)

Changing the Magnification

200% - |E) |-E-) Y - - |E| m - n:u:n:u - OJ - -

Display the image at actual pixel size (100%).

Click the [[§ ] button to display the image at the set
magnification displayed. If the [[EJlIiE]] button is used to
enlarge/reduce the image, the magnification set for this
button also changes accordingly*.

*Excluding actual pixel size (100%)

Enlarge/reduce the image.

Revert the zoomed image back to fit-to-window view.

Comparing with a Pinned (Fixed) Image

You can split the window into two sections, and compare the images on
the left and right by “pinning” an image in the left section then scrolling
images in the right section. It improves efficiency of image selection.

K1 200% ~ |::_ -B] v 1 " |E| m - n:u:n:n - OJ - ﬂ -

Select an image and click the [[iE]] button.

1R

o il | B |

Pinned (fixed) image

The window divides into left and right, and the selected image is
pinned.

When you pin an image and perform scrolling, the image on the
left (pinned image) remains and only the image on the right is
scrolled, which is convenient for image selection.

To pin another image, select the image, then select [Pin] from the
menu that appears when you right-click with the mouse.

After pinning an image, you can click the [] button to switch
between top-bottom and left-right split screens.
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Displaying Multiple Images at the Same Time

x1 200% ~ |%) |-B Y Y Y |E| B v dm v OJ A v

Select multiple images, and click the [[&]] button.

The selected image is displayed.
You can display up to 8 images.

® On 32-bit OSs, this function is not available.
(The [[&@)] button is not displayed.)

Displaying Grid Lines

x| 200% v |%) |-B Y Y Y |E| B - n:u:n:u - OJ v -

Click the [[j] button beside the [[E]] button, and set
the spacing between grid lines on the menu that
appears.

To set the spacing, enter values (8 to 256, in pixels), or move the
slider.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[E]]] button.
The image with grid lines is displayed.

Displaying AF Points

%1 200% ~ |%) |-E] v ‘F ‘F |E| BH v gm v OJ - ﬂ A

Click the [[§] button beside the [[E]] button, and
select the item to display on the image on the menu
that appears.

Select [Show only AF points in focus] or [Show all AF points].

Select an image and click the [[E]] button.
An image with the AF points selected in step 1 is displayed.

@ AF points are not displayed for images whose image size has been

changed and then been converted and saved (p.93), images for
which you selected an effect other than [Shot settings] as correction
of fisheye lens distortion aberration, or images which have had
settings specified during RAW processing on the camera for
distortion correction or chromatic aberration correction.
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Displaying Areas Beyond the Set Range with
Warning Indicators (Highlight/Shadow
Warning)

You can set up warning indicators for both highlighted and shadowed
parts, which is effective for checking the clipped highlights and shadows
and preventing excessive adjustment of an image. Where the area on
the image has exceeded the set range, you can display the highlighted
part in red and the shadowed part in blue.

x| 200% - |a |-B YYY |E| B - n:u:n:u - OJ A -

Click the [[]] button beside the [EF]] button, and
specify settings on the menu that appears.

Highlight/shadow warning display settin... n

Show shadow warnings
Threshold{0-64) 32
Warning color -
Show highlight warnings
Threshald(192-255) 254
Warning color -

Cloge

Checkmark the [Show highlight warnings] and [Show shadow
warnings] checkboxes and enter the warning values.

You can also select different warning colors from the dialog that
appears when you click the [[ .. ]] button.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[EF]] button.

On the opened image, if there is an area that exceeds the value
entered in step 1, the highlighted part of that area is displayed in
red and the shadowed part is displayed in blue. If you selected
different warning colors, the parts are displayed in the specified
colors.

Comparing Pre- and Post-Editing Images
(Single-Image Display)

x| 200% ~ |§) |-!—-:1 "vv |E| HH v gm v Oj - ﬂ v

Select an image that is being edited and click the
[[iE] button.

By clicking the button, the display switches between the image
before editing and the current image (being edited).
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Comparing Pre- and Post-Editing Images
(before/after comparison) Arrange vertically/
horizontally (two-screen display) / Split
vertically/horizontally (split-image display)
You can display before and after versions of an adjusted image in the
same window and check the adjustment results.

This function allows you to adjust an image while comparing the original
image and image being edited.

x| 200% v |%) |-B ""Y |E| B - n:u:n:u - OJ v -

Select an image that is being edited and click the
[[E&] button.

i

i il | B )i

The image is displayed in two-screen display (Arrange vertically).

The image before editing is on the left, and the currently edited is
on the right.

Change the image display.

The display switches in the following order by clicking the [[ii]
button.

Arrange vertically (two-screen: left/right) > Arrange horizontally
(two-screen: top/bottom) = Split vertically (split-image: left/right)
- Split horizontally (split-image: top/bottom)

Displaying Image Properties
Display the shooting and recipe information for an image in the screen.
You can select items to be displayed.

x1 200~ @ @ [F~~[1~ M =~

R

Click the [[]] button beside the [[[i]] button.
The [Properties display settings] window appears.
Specify display settings.
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Select [Display settings for preview properties] from the
[Properties to display] pulldown menu.

Specify display items with the [Add >>] button and [<< Remove]
button. Items that can be selected appear in the list box at left,
and actually displayed items appear in the list box at right. You
can also change the display order with the [Move Up] button and
[Move Down] button.

After specifying settings, click the [OK] button.

With the [Preview properties font] option, you can specify the font
used for information displayed in the preview window.

Select an image and click the [[[if]] button.

The image and properties selected in step 2 are displayed in the
screen.

If the recipe contents of an image being edited are displayed in
before/after comparison (two-screen display/split-image display),
edited items are displayed in red.

@ All the property items may not be displayed depending on the
combination of window, preview window, or the size of thumbnails.

Checking an Image in Multi-Function Preview

The preview window shows the coordinates of the mouse cursor and the
work color space. By switching to multi-function preview, you can also
check image details in the same way as the main window (multi-layout).

Select the [Tools] menu » [Preview screen display
settings], and then [Multi-function preview] from the
dialog that appears.

Open the preview window (p.18).

A multi-function preview with various functions at the bottom of
the screen is displayed.

® Digital Photo Professional 4 - [IMG_0001.CR2]

File Edit View Thumbnails Preview Label Adjustment Tools Window Help

A 200 © ® [ H-FErE - E -

M273% 75 s % s s

For how to use the displayed functions, see “Viewing an Image in
the Main Window (Thumbnail Layout)” (p.13) and “Checking an
Image Using the Preview Control Panel” (p.21 to p.25).
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Checking an Image in Second Windows

Second windows are preview windows that you can open additionally
for thumbnails and image previews. You can display up to 4 second
windows for an single image to check the focus in all parts of the image,
etc.

Select an image, and then select [Show second
screen] from the menu that appears when you right-
click with the mouse.

Digital Photo Professional 4 - (IMG_0001.CR2) B3

T T

& Digital Photo Professional 4 - [IMG_0001.CR2)

A second window is displayed.

To display an additional second window, repeat the operation.
You can change the size of second windows as desired.
Click the displayed image to switch between actual pixel size
(100% view) and fit-to-window view.

When you magnify an image in the second window, the right-
clicked position on the image will be the center for the
magnification.

@ On 32-bit OSs, second windows cannot be displayed.
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Opening and Closing Window Panels (Panes)

Panels (panes) at the top, bottom, left, and right of each window can be
closed to suit the tasks being performed.
You can use DPP in an optimal layout.

Click the [|J"l]] for a panel to open or close.

Example: main window (thumbnail layout)

When a panel is closed, you can point to [[JJlJ] with the mouse
to temporarily open the panel.
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Changing the Display Method and Order of Palettes

For any palette (tool palette, navigator palette, histogram palette, quick
check palette, and camera control palette), you can change how the
palette is displayed (docked/floating), or the display order of multiple
docked palettes.

Changing the Display Method (Dock/Float) of Palettes

Right-click on the palette’s title bar (where its name
is shown) and click [Dock/float] in the dialog that
appears.
A docked palette is then displayed floating, and a floating palette
is then displayed docked.

To revert to the original display method, repeat the same
operation again.

Rearranging Palettes

When multiple palettes are docked, you can rearrange their order from
top to bottom.

Right-click on the palette’s title bar (where its name
is shown) and click [Move one up] or [Move one
down] in the dialog that appears.

The order of the palettes is changed.
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Exiting DPP

In the main window, select the [File] menu P [Exit].

Close window Ctrl+W
Save Ctrl+S
Save As.. Ctrl+Shift+5
Convert and save... Ctrl+D
Batch process... Ctrl+B
Save still image from movie...  Ctrl+Shift+D
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+Shift+P

Plug-in printing

Add to collection

Remove from collection

Clear collection

Ctrl+G
Ctrl+5hift+G

Select collection

Delete collection

Bookmark

Remove bookmark

Move to Recycle Bin

Del

[ Exit

Alt+F4

DPP exits.

@ A confirmation dialog box for saving the images appears when you
try to exit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images
adjusted.
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3 Organizing and Sorting Images

Efficiently Checking/Sorting Images............ccccc........ 31
Sorting IMages ........vvveeeeeiiiiieieeeeeeeeeeeee e, 33
Attaching Check Marks............ccceeeeeeeeeeiieeiicinnnee 33
Setting Ratings ... 33
Sorting Images in the Main Window ..............cccccce...... 34
Attaching Check Marks in the Main Window .......... 34
Setting Ratings in the Main Window....................... 34
Arranging Images in the Main Window....................... 36
Arranging by TYPE ......oooiiiiiiiieeeeeee e 36
Arranging Freely ..........cooooiiiiiiiiieeeeee e 36
Displaying a RAW Image and JPEG Image as a Single
0 F= o [ TSRS 37
Checking Image Information............ccccociveiiiiinnenn. 38
Organizing IMages .......ccceeeeeeeeeeeeeeeeeee e 39
Deleting an Unwanted Image ..............cccccvvvvvveeennnnnn. 39
MOoVING IMAJES ......eveiiieiiiiiiiiie e 39
Moving Images in Folders ..........ccccccoooiiiiiciiiieeennn.. 40
Registering Frequent-Use Folders (Bookmark
Registration) .........cccccooooiiiiiiii e 40
Deleting Bookmarks .............coooeeciiiiiiieeeeeeeeeeeeee, 40
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can sort images into groups.
Note that this function does not apply to movie files.

Select multiple images to check in the main window.

Display the quick check window.
Click the [Quick check] button.

@ Digital Photo Professional 4 - [Folder: C:\Users\xood Desktop\xoooo_03]

File Edit View Thumbpails Preview Label Adjustment Tools Window Help

Remote Shooting

Edit Irmage 1 « Check

Folder Baok mark ON OFF o'

=-[ i Desktop
The quick check window appears.

Click the [[E] or [[] button to switch between
images to be checked.
Quick check window

 Digital Photo Professinal 4 - [Folder: C:AUsers\xoo\ Desktopioaa 03]

All the images displayed in the main window can be checked in
the quick check window.

If you click the [[Bll] button, the first image is displayed, and if you
click the [[g]] button, the last image is displayed.

Click the [[B]] button to return to the main window.
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Click the area you want to enlarge.

- - o T e - - L -

The area you clicked is displayed at 100% (actual pixel size).
To change the display position, drag on the image.

If you click the [ |E2] button, you can display the image at 50%.
Click again to revert to the full view.

To exit, click the [[E]] button.

In addition to 100% and 50%, you can display images at 12.5%,
25%, 200%, 300%, and 400%. Click the [ﬂ] button beside the

] button on the screen, and select a magnification from the
menu that appears.

If you click the [ [EZ] button (the selected magnification appears
on the button), the image appears at the selected magnification.
However, after the quick check window is closed, the image
returns to its original 50% view.

When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF
points are not displayed for images which have had their image
size changed and then been converted and saved (p.93), which
have had settings specified during RAW processing on the
camera for distortion correction and chromatic aberration
correction, which are composited, or which are created as HDR
(High Dynamic Range) images.

Ay

-@> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switching between images using the keyboard

You can also switch between images by pressing the <—> or <«>
key.

Switching between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operations using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [[El] to [E]-

Thurmbnail position

o Bottom

P L=it
v"1 v"2 \/3 v"4 \.—"5 . Click

The selected check mark appears in the upper left of the window.

Check mark

Click the [Clear] button to remove the check mark.

@ The values of check marks attached to images in versions before
DPP 4 are not maintained.
You can also attach check marks from the menu that appears by
right-clicking with the mouse on an image in the main window.

Setting Ratings
Display the image you want to rate, and then click
any one of the [¢].

O Bottom ® L=it
\/1 \/2 \f3 \/4 \/5

Click

+ < 2/16

. AF points

Info

The rating is set and an icon corresponding to the selected [$%]
appears in the upper left of the window.

(Window shown with a rating of three [%])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon

To cancel the rating, click the same [¢%] as when the setting was
made on the right of the window.

@ As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks

or setting ratings (indicated with [s%] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [El] to [E].

L T 10 : Select

. i | B | e

IMG_0001.CR2

N2 ORa s Iy G Gl = e e Y CIiCk

The selected check mark appears in the upper left of the image
frame.

Check mark

Click the check mark again to remove the check marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [¢].

; gl | B | b

Select

Click (changes to [%¢] after clicking [ @])

The rating is set and an icon corresponding to the selected [§%z]
appears in the image frame.
(Sample window shown with a rating of three [$%] as an example)

.‘llfi‘-

. 8| BN e

Rating icon

To cancel the rating, click the same [$%] as when the setting was
made.
Set [Reject] with the [Label] menu or the quick check window

(p.31).
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~

:@/3 To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

@ The [Label] menu can also be used to attach check marks and set
ratings.

You can display and change the rating settings set in DPP with

other EOS software and with any supported EOS camera (for the

EOS 7D, version 2.0.0 or later firmware) except the EOS-1D Mark

IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS-1D Mark Il N,

EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D

Mark I, EOS 5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/

EOS 20Da, EOS 10D, EOS D2000, EOS D30, EOS D60, EOS

550D, EOS 500D, EOS 450D, EOS 1000D, EOS 400D, EOS

350D, and EOS 300D.

« EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

» With any supported camera (for the EOS 7D, version 2.0.0 or
later firmware) except the EOS-1D Mark IV, EOS-1Ds Mark |ll,
EOS-1D Mark lll, EOS-1D Mark II N, EOS-1Ds Mark Il, EOS-1D
Mark Il, EOS-1D, EOS-1Ds, EOS 5D Mark Il, EOS 5D,

EOS 50D, EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS
10D, EOS D2000, EOS D30, EOS D60, EOS 550D, EOS 500D,
EOS 450D, EOS 1000D, EOS 400D, EOS 350D, and EOS
300D:

Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change in DPP the rating
settings set for images on any supported EOS camera (for the
EOS 7D, version 2.0.0 or later firmware) except the EOS-1D
Mark 1V, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS-1D Mark II N,
EOS-1Ds Mark II, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D
Mark Il, EOS 5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/
EOS 20Da, EOS 10D, EOS D2000, EOS D30, EOS D60, EOS
550D, EOS 500D, EOS 450D, EOS 1000D, EOS 400D, EOS
350D, and EOS 300D.
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Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them

individually.

Arranging by Type

Select the [Thumbnails] menu P [Sort] » desired item.

The images are arranged in the order according to the selected

item.

Main sort items
File name: ascending order

Description

Images are sorted by file name in
alphanumeric order (0 to 9 » A to Z).

Extension: ascending order

Images are sorted in the following order:
RAW images - JPEG images - TIFF
images = MOV movies = MP4 movies.

Shooting Date/Time:
ascending order

Check mark: ascending order

Images are sorted by shooting date and
time from the earliest.

Images with check marks take priority
and are sorted in number order.

Rating: ascending order

Camera Model Name:
ascending order

Sorted in order of fewest [§%].

Sorted in order of least digit used in the
camera model name. (Ex.: EOS-1D X
- EOS 6D)

Lens: ascending order

Sorted in order of shooting lens with
shortest focal length.

ISO speed: ascending order
Shutter speed: ascending order

Sorted in order of lowest speed.

Sorted in order of fastest shutter speed.

Aperture value: ascending order
Focal length: ascending order

Sorted in order of lowest aperture value.

Sorted in order of shooting lens with
shortest set focal length.

* You can also arrange images by [Image Size], [RAW Type],

and [Recipe editing status].

* Descending order sorts all items in the reverse of ascending order.

Arranging Freely

Drag and drop the image to the desired location.

The image moves to the desired location.

You can also select multiple images (p.35) and move them.

The order of rearranged images is temporarily registered as
[Custom] in the [Filter/Sort pane] and maintained until you exit
DPP or select another folder in the folder area.

Select the [Thumbnails] menu P [Sort] » [File name] and [Ascending]
to revert to the order before the images were rearranged.

¥

5@5 Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View Settings] tab sheet in [Preferences] to maintain
the order of images without changing the image file names (p.156).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.132).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Thumbnails] menu » [Group RAW and
JPG versions].
The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(R+J)] mark (p.161).

? RAW images with the extension “.CR2” or “.CR3” can be
displayed as a single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2”, “©.CR3”, and
JPEG images simultaneously. Images that have been simultaneously
shot with a camera that shoots RAW images with the extension “.CRW”
or “.TIF” cannot be displayed as a single image.

A/

=@> When a single image is displayed
Image displayed
The RAW image is displayed in all windows.
Edited image
The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.
However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.
* Deleting an image (p.39)
* Moving or copying an image (p.39)
* Checkmarking (p.33, p.34)
» Rating (p.33, p.34)
* Rotating an image (p.13)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[(R+J)] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2.

@ If you cancel selection of [Group RAW and JPG versions], the RAW
image and JPEG image are displayed as separate images.

Introduction/
Contents

Downloading
Images

Viewing
Images

Sorling
Images

Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back

Movies and Saving
Still Photos

HDR PQ
Mode

Specifying
Preferences

Q0O

37



Introduction/
Contents
. . Shooting information is displayed in the [Exif Information] tab
Checking Image Information sheet, while IPTC* information appended to the image after oA
. . shooting is displayed in the [XMP/IPTC Information] tab sheet. ownloading
Select the image for which you want to check the N9 played in the [XMF I Images
imaae information IPTC* information provides additional comments on images,
9 ’ such as captions, credits and the shooting location. The
Select the [View] menu » [Info] information is sorted into 5 different categories and can be Y'erng
. . . L mages
. . . . viewed by selecting [Description], [IPTC Contact], [IPTC Image], 9
The image information window appears. [IPTC Content] or [IPTC Status] from the list box in the [XMP/
Select a tab sheet and check information. IPTC Information] tab sheet. f'rg;g
* International Press Telecommunications Council (IPTC)
Image information window The contents of the [Exif Information] tab sheet will vary
[Exif Information]  [XMP/IPTC Information] [Recipes] depending on the camera model. _ _ Editing
tab sheet tab sheet tab sheet Recipe contents applied to an image are displayed in the 9
IMG_0001.CR2 x| IMG_0001.CR2 x| IMG_0001.CR2 x| [Recipes] tab sheet.
[ EXif Tnformation | XMP/IPTG Information | Recipes Exif Information _AMP/P TG Information | Recipes Exif Information | XMP/IPTG Infor mation | FEGIES | E -
Ttem Value ~ I[Descmuhun ] - Trem Value A Pl'lntll"lg
et e it Images
Camera Modzl Canon EQS XM [Creator] Ef;f,’:j‘“a ([,Luamscapa
Firmare Firmuare Wersion XX HHHOXRAON Shadow 0
Shaating Date/Time  XXXH/XN/XX XXKNXY [Oreatars job Titke] g‘jg:"j’;‘ne gg Processing
Owrer's Name ) MO0 Color saturation ' Lar e Numbers
Shooting Mode Bperture-Priority AE Linear oft (¢]
Tolshutter Speed) 1740 e Black poin o of RAW Images
AvlAperture Valus) 56 mj‘:‘;;m ggg
Metering Mode Evaluative Metering [Description Witer] Sharpess Strength: 40 Finer
Exposure Gompensa.. PEHETIHEOR Auto Lighting Optimizer  Standard
RGE tore curves Original
o o e, Remote
Lens EF17-40mm /4L LiSM [Copyright Status] E“"”’ adiustment ;”n' Shooti ng
Focal Leneth W 0mm RHHHHRHHRR S:furahnn «100.0
Image Size FCK R Red off
fspect ratio 82 T Oranee o .
noee Qualty  RAW S Greon o Playing Back
el i D000 i on Movies and Savin
White Balance Mode  Aute ;’4‘;2:‘3 o Still Photos
AF Mode Manual focusing Lens correction On
Picture Style Landscape Digital Lens Optimizer Ot
Shaszness ‘ v o e ¥
< > < > \\ | // . . ) ) HDR PQ
=@> Convenient uses in the main window Mode
Switching displays
If a different image is selected in the main window when the image PSP?Cifying
information window is displayed, the image information for that image & @
will be displayed. —
Difference with the thumbnail with shooting information @ @
Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in @

[Thumbnails] menu » [With shooting info] (p.14). 38



Organizing Images
This section explains how to delete unwanted images, move or copy
images, etc., to organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Move to Recycle Bin].

Close window Ctrl+W
Save Ctrl+5
Save As.., Ctrl+Shift+5
Convert and save... Ctrl+D
Batch process... Ctrl+B
Save still image from movie...  Ctrl+Shift+D
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+5hift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+Shift+G
Clear collection
Select collection »
Delete collection »
Bookmark
Remove bookmark

[ Maove to Recycle Bin Del
Exit Alt+F4

The image is moved to the [Recycle Bin] and is deleted from DPP.
The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]
on the desktop.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.

File Edit View Thumbnails

v Llabel Adjustment Tools Window Help

LT 1
DATAZ (D) Sl | B e
DATA (E) = 1?43
REMOVABLE DISK (1) @ 1502200,
&8 BD-RE DRIVE (%)
-= REMOVABLE DISK (K) IMG_0r 1.CR2
- REMOVABLE DISK (L) i
- REMOVABLE DISK (M:)
Libraries
¥ Network
Holiday

F.0

The images are moved or copied to the destinaon folder.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

File Edit View Thumbnails Preview Label Adjustment Tools Window Help
Edit Image
Folder

=[] Desktop
-l oo

. Documents
R Downloads

E Pictures
T

' Travel ”
0 T T
S| B e
B DATA2 (D) I=1;
== DATA (E) @ 1503200
== REMOVABLE L ISK (I
48 BD-RE DRIVE 1})
—+= REMOVABLE [ ISK (K)
—= REMOVABLE [ ISK (L)
= REMOVABLE [ ISK (M)

IMG_0001.CR2

F3.6

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders are displayed in the [Bookmark] tab sheet in the main
window.

Select the folder for which a bookmark is to be
registered.

File Edit View Thumbnails Preview Label Adjustment Tools Window Help
Re
Folder

&= Deskiop
- oo

Desktop
.} . Documents
' Downloads
" F Music

- = pictures
‘ = . Travel
‘ ZZ r Videos
B1-Ge 05 (C)
B DATA2 (D)
g DATA (E)
Bt REMOVABLE DISK (1)
--&& BD-RE DRIVE (%)
- REMOVABLE DISK (K
- REMOVABLE DISK (L)
- REMOVABLE DISK (M)

nnnnnn

- [Holiday

Select

F4.0 f

Select the [File] menu » [Bookmark].
The folder selected in step 1 is registered in the [Bookmark] tab
sheet in the main window.

Deleting Bookmarks
You can delete a folder registered in [Bookmark].

Select the [File] menu » [Remove bookmark].
The selected folder is deleted from bookmarks.
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4 Editing Images

RAW IMages ...
RAW IMages......cooooiiiiiiiiii e
RAW Development ..........cccoooiiiiiiiiiiiiiiieeeeeeen
When RAW Development is to be Done....................
Advantages of a RAW Image .............eevevvvvviinnnnnnnnnnes

Editing JPEG and TIFF Images ............ccceevveeeennnnee
Tool Palettes ...

Editing with the Basic Adjustment Tool
Palette.....oovneeee

Adjusting Brightness ...,
Changing the Picture Style ..........cccooooviiiiiiiiiiin,

Using a Picture Style File .........c.ccccooceevennn...
Adjusting Color Tone by Changing White Balance....
Adjusting Color Tone Using Click White Balance......
T Adjusting White Balance with Color
TempPerature ..........coeiie i
Tuning White Balance...............cccceeeeeeenne...
Adjusting Contrast ...........oooeiiiiiiiiiiiiiiiiiis
Adjusting Brightness of Shadows/
HIghlights ..o
Changing Color Tone and Color Saturation...............
Adjusting Monochrome.............ccvieiiiiiieiieeiiiinn.

) Adjusting Dynamic Range............ccue........
Adjusting Gradation and Luminance Automatically ...
Using the Auto Lighting Optimizer...........................
Adjusting Image Sharpness..............ueeveveeeeiininnnnnnnnns

Detailed Setting of Image Sharpness ....................

Editing with the Tone Adjustment Tool
Palette.....cooviiee

53

53
54

54
55
55

56
S57
58
59
60

61

Adjusting Brightness and Contrast..............ccceeeee.... 61
Adjusting Color Tone Using Click White Balance....... 62
T Adjusting Tone CUrVe ........ccceeeeeeveeeeecveeeenee. 63
Example of a Tone Curve Operation...................... 64
Adjusting Dynamic Range...........c..ccccoou...... 65
Using the Auto Lighting Optimizer...........cccccccooeneee. 65
Editing with the Color Adjustment Tool
Palette ..., 66
Editing with the Color Adjustment Tool
Palette ..o 66
Adjusting a Specific Color Gamut........................... 66
Adjusting Hue and Saturation for an
Entire IMage ... 67
Adjusting in Monochrome...........ccccceeeeeeeieeiiccnnnnneee. 67
Editing with the Detailed Adjustment
Tool Palette ..o 68
Reducing NOISE .........cooiiiiiiiiiiie e 68
Adjusting Image Sharpness.............cccceevevvirieeneeenennn. 69
Reducing Color Moiré in an Image..........cccccvveeeee.... 69
Editing with the Trimming/Angle
Adjustment Tool Palette ..............coooiiiiiiii, 70
Editing with the Lens Correction Tool Palette.......... 73
Correcting Lens Aberration.............occccceeeeiiiieeneeeee, 73
Making Corrections..........cccccvvveieiieeeeeeiceecceeeee e, 74
Effects of Distortion Correction for Fisheye
LENSES it 75
Shooting Distance Information Slider ......................... 76
Correcting Multiple Images ata Time................vvveeeee 77
Digital Lens Optimizer ... 77
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Using the Digital Lens Optimizer ..........cccccccceeeeeenn. 78
Adjusting Image Sharpness...........ccccccvvvriiiiiiiieeeeeenn, 80
Editing with the Partial Adjustment
Tool Palette ..o 81
Making Partial Adjustments to Images ([Brightness],
[Contrast], [Hue], [Saturation])..........cccccuvveeeeeeeeennnnn. 81
Making Partial Adjustments to Images ([Reduce
COIOr MOIIE]) .. 83
Adjustment GrouPS ........eeeeiiiireeee e 84
Editing with the Dust Delete/Copy Stamp
Tool Palette .........ooo i 85
Performing Automatic Dust Erasure Processing ....... 85
Automatic Dust Erasure Processing in the
Main WiNdOW .........oovieiiiiiiiie e 86
Manually Erasing Dust (Repair Function).................. 87
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION) ..o 89
Setting Work Color Space........cccccceeeeeviiiiciiieeeeennn. 90
Using the Soft-Proof Colors Function....................... 91
Specifying the Size when Opening RAW Images .... 92
(eecmirr ) Saving Editing Results...............ooeennil. 93
Saving Editing Contents to an Image ........................ 93
Saving as a separate image ........cccccceeeeveeeiiiinnnnnnnnn. 93
Re-Editingan Image..............cccoeeeeis 95

Utilizing Adjustment Contents (Recipe).... 96
Copying a Recipe and Applying to Another Image.... 97
Savinga Recipeas aFile.....c.cccccoeiiiiiiiiiiii 97
Loading and Applying Recipes ..........cccccuveeeeeeeeeeenn. 98

(eecmire ) Adjusting by Comparing Multiple

IMAGES ... 99
Editing Efficiently ............ccccoooo 100
Editing in the Edit Image Window............................. 100
Changing the Thumbnail Display Position to
Horizontal ..........coevvieiiiiiiiiccee e 101
Gathering and Editing Images in the Collection
WINAOW.....oiiiiiiiiiiieeeeeeeee s 102
Compositing Images............cccceeeeeennn. 104
Compositing Methods............ooooiiiiiii 107
Creating HDR (High Dynamic Range)
IMAGES ... 108
Using the Dual Pixel RAW Optimizer........ 111

Microadjustment of the Position of Maximum Sharpness
and Resolution Using the Depth Information Contained

within the Dual Pixel RAW File..........cccoovvveeeiicnnnnne.. 111
Reposition the Viewpoint or Foreground Bokeh for
a More Pleasing Result ............cccccviiiiieieieeccecce, 112
Reduces the Appearance of Ghosting in Images..... 113
Using Depth Compositing.......... 115
Supported IMageS ........cevvvveeeeiiiiiiiiiiiiieeeeeee e, 115
Using the Depth Compositing Tool.......................... 115
Using the Depth Compositing Editing Tool............... 117
T Transferring a RAW Image to
PhotoShOp ...eeiiieee 119

Customizing the Main Window Toolbar .... 120
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* Sections with and in “4 Editing Images”
support not only RAW image editing but also JPEG/TIFF image

editing.

: All the functions explained in the section support
JPEG/TIFF image editing.

: Certain functions explained in the section support
JPEG/TIFF image editing.
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RAW Images
RAW Images

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

RAW Development

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“‘development”.

When RAW Development is to be Done

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP. As a result, RAW images displayed
in DPP are images whose development processing has been
completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

Advantages of a RAW Image

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Therefore, it is the
perfect data for users who want to get creative with the images after
shooting, as you do not have to worry about image deterioration.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe” (p.96).

Y

" RAW image

Contents adjusted using the tool

palettes can be handled
—1| individually as a recipe file

(extension “.dr4”) (p.96, p.97).

7

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.97), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.98). However, a
recipe file with saved RAW image adjustments cannot be applied to
JPEG or TIFF images.
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the tool palettes below.

» Tone Adjustment tool palette

+ Color Adjustment tool palette

* Detailed Adjustment tool palette

» Trimming/Angle Adjustment tool palette

* Partial Adjustment tool palette

* Dust Delete/Copy Stamp tool palette

* Settings tool palette
Because adjustments made with these tool palettes (the recipe) only

change the image processing conditions, the “original image data itself”

remains unaffected. Consequently, there is none of the image
deterioration that normally accompanies editing and you can readjust
your image any number of times.

JPEG TIFF lmage data

Image processing conditions information

f— Contents adjusted using the tool
palettes can be handled
—1 individually as a recipe file
(extension “.dr4”) (p.96, p.97).

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.97), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.98). However,
recipe data with saved JPEG or TIFF image adjustments cannot be
applied to RAW images.
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Tool Palettes

With DPP, you can adjust images with the tool palettes by switching
between various tool palette windows according to your editing
requirements. Since adjustments made with the tool palettes only
change the image processing conditions, the “original image data itself’
remains unaffected. As there is no image deterioration that normally
accompanies editing, you can readjust your image any number of times.
The various functions of the tool palettes are explained in more detail
under the respective topics.

Trimming/Angle Partial
Adjustment tool Adjustment
palette tool palette

LenS Tool palette
Correctiontool :
palette

Basic
Adjustment Copy Stamp
tool palette tool palette

Detailed Settings tool
Adjustment palette

tool palette

Tone Co!or
Adjustment :[Ac\)c(i)J ;Js;rlr;?trg
tool palette p

Picture Style I~

(Standard) - Erowse...
G 13 & it

Maove midpoint to match

Basic Adjustment tool palette
Makes basic adjustments to a RAW image (p.48).

Tone Adjustment tool palette

Adjusts the tone curve and applies the Auto Lighting Optimizer (p.61).

Color Adjustment tool palette

Adjusts the hue, saturation and luminance of a specific color space. The
hue and saturation for an entire image can also be adjusted (p.66).

Detailed Adjustment tool palette

Reduces noise and adjusts the image sharpness (p.68).

Trimming/Angle Adjustment tool palette
Crops an image and adjusts the image angle (p.70).

Lens Correction tool palette
Corrects lens aberration in the image (p.73) and applies the Digital
Lens Optimizer (p.78).

Partial Adjustment tool palette

Adjusts the selected area of an image (p.81).

Dust Delete/Copy Stamp tool palette

Erases dust from an image and corrects image by copying sections
of the image (p.85).

Settings tool palette

Configures the work color space (p.90).
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g% Using the different tool palettes

We recommend that you use the Basic Adjustment tool palette to make
adjustments to RAW images. However, if you find that the Basic
Adjustment tool palette does not offer a sufficient range of adjustments,
or if you want to use specific functions that are only available in the Tone
Adjustment tool palette (p.61), completing initial adjustments with the
Basic Adjustment tool palette and then using the Tone Adjustment tool
palette to make just the minimum of adjustments needed is
recommended.
For noise reduction (p.68) and lens aberration correction (p.74), you
should first complete necessary adjustments in the Basic Adjustment
and Tone Adjustment tool palettes, and then adjust with the Detailed
Adjustment tool palette (p.68) and Lens Correction tool palette (p.73).
You can click the [] button at the bottom right of the main window
to show/hide [Tool palette].
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JPEG/TIFF

Editing with the Basic Adjustment Tool Palette

The Basic Adjustment tool palette makes basic adjustments to RAW
images. With this tool palette, you can adjust the image brightness, set
Picture Style, adjust the white balance, adjust the contrast, adjust the
color tone and saturation, adjust the dynamic range, apply the Auto
Lighting Optimizer and adjust the image sharpness.

Note that the only adjustments you can make to JPEG/TIFF images are
applying the Auto Lighting Optimizer and adjusting the image
sharpness.

Select an image in the main window, etc.

Display the Basic Adjustment tool palette.

Tool paletts

Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

Tool palette

Reverts the image to
the original settings

Enter a numerical
value

Drag the slider left or right

@ The adjustment range is —3.0 to +3.0 (in 0.01-stop increments when
entering a value).
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Changing the Picture Style

If the image looks different from what you visualized at the time of
shooting, you can get it closer to what you expected by changing the
Picture Style. Even if you have saved the image (p.93) with
[Monochrome] (p.55) selected, you can still change to another Picture
Style at any point by simply selecting a Picture Style other than

[Monochromel].

Ficture Style

By (Standard) o

Gamma adjustment

0 50 40 -20

Move midpoint to match

Reverts the image to
the original settings

¥

B Linsar

Select

20 40

Picture Style

Description
The Picture Style set with the camera when the
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Monochrome  You can also adjust with [Filter effect] or [Toning

effect] (p.55).




Picture Style

(Picture Style file
registered in the

camera)

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

[Picture Style file
applied in DPP]

The name of the Picture Style file applied in DPP is
displayed in [ ].

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style.

[Auto] is not applied to images shot with the EOS-1D Mark 1V,
EOS-1Ds Mark Ill, EOS-1D Mark lll, EOS-1D Mark II N, EOS-1Ds
Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D Mark I,
EOS 5D, EOS 7D, EOS 60D/EOS 60Da, EOS 50D, EOS 40D,
EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS D2000, EOS
D30, EOS D60, EOS 550D, EOS 500D, EOS 450D, EOS 1000D,
EOS 1100D, EOS 400D, EOS 350D, EOS 300D, PowerShot G3
X, PowerShot G1 X Mark I, PowerShot G7 X, PowerShot G9 X,
PowerShot SX60 HS, PowerShot G5 X, PowerShot G16,
PowerShot S120, PowerShot G1 X, PowerShot G15, PowerShot
S110, PowerShot S100, PowerShot G9, PowerShot G10,
PowerShot G11, PowerShot G12, PowerShot S90, PowerShot
S95, PowerShot SX1 IS, PowerShot SX50 HS, or PowerShot
SX70 HS. When changing the Picture Style with several images
selected, although you can select [Auto] if images shot with any
supported camera other than the above are included, [Auto] will
not be applied to the images shot with the above cameras.

You can apply [Fine Detail] to all images shot with supported
camera models except the PowerShot G3 X, PowerShot G1 X
Mark I, PowerShot G7 X, PowerShot G9 X, PowerShot SX60
HS, PowerShot G5 X, PowerShot G16, PowerShot S120,
PowerShot G1 X, PowerShot G15, PowerShot S110, PowerShot
S100, PowerShot G9, PowerShot G10, PowerShot G11,
PowerShot G12, PowerShot S90, PowerShot S95, PowerShot
SX1 1S, and PowerShot SX50 HS.

You cannot select [Auto] with multiple-exposure RAW images
created with the camera.
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Using a Picture Style File

A Picture Style file is a Picture Style extension file.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon website effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Click the [Browse] button in the [Picture Style] panel.

Gamma adjustment LA

B Ui

G0 =40 =20 00 20 40

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.
To apply a different Picture Style file, follow the procedure from
step 2 again.

@ The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source to match the scene at the
time of shooting an image of, for example, pale-colored flowers.

Tool palette

‘White balance adjustment

Reverts the image to

* ] the original settings

F

o ]

Select

i3 () is the white balance set on the camera when the image was shot.

* When a mode in the Creative Zone is selected on the camera,
the white balance set is displayed in ().

 When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.52).

@5 Tune with color tone

To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.55) for tuning towards your expectations.

You cannot register the adjustment results as personal white
balance (p.127) when you have selected [ jf%§( )] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Tool palette

Click

The coordinates of the cursor position and

the RGB values (8-bit conversion) Reverts the

image to the
original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click
the [[E3l}] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

Tool pa lette

Caolor temperature -

s

Displays the value of
the setting

Drag the slider left or right

@ The adjustment range is 2000 to 10000K (in 10K increments).

Tuning White Balance

This is a function that makes fine adjustments to the white balance.

Using this function, you can achieve the same effects as third-party

color temperature conversion filters and color correction filters. The
adjustable range is £10 steps. This function is aimed particularly at high-

end users who are familiar with the roles and effects of color

temperature conversion filters and color correction filters.

Tune the white balance by dragging the point in the
adjustment screen in the [Fine-tune] panel.

Fine-tune

Enter the values to set

Drag Drag the sliders left
or right

B stands for blue, A for amber, M for magenta and G for green.

The color is adjusted towards the color to which the point moves.

You can also fine-tune your adjustment by using the sliders or
entering the adjustment values.

® To register the adjustment outcomes as a personal white balance
(p.127), select a setting other than [ ( )] from the [White
balance adjustment] list box before tuning the white balance. If
you selected [|f4( )] from the list box and tuned the white
balance, you cannot then register the outcomes as a personal
white balance.
You cannot change or adjust the white balance in multi-exposure
RAW images generated on the camera.

@ The adjustable range is 0 to £10 (in 0.1-stop increments when
entering a value).
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Reverts the image to
the original settings

Picture Style

Yy (Standard) -

Gamma adjustment

Drag the slider left or
right (9 steps)

Enter a setting (in
0.1-stop increments)

Adjusting Brightness of Shadows/Highlights
You can adjust the brightness of shadows and highlights in an image.

By adjusting only shadows or highlights in an image, you can reduce the
effects of clipping in shadows and highlights.
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Changing Color Tone and Color Saturation

Tone and overall color saturation can be adjusted.
If Picture Style (p.49) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

Reverts the image to
the original settings

Drag the sliders left or
right

or tone N— + ju—

Enter a setting (in

saturation —— 0.1-stop increments)

Color tone: Move the slider to the right to make tones
more yellowish, and to the left to make tones
more reddish.

Color saturation: Adjusts the overall color intensity for the
image. Move the slider to the right for more
intense colors, and to the left for less intense
colors.

@ The adjustment range is —4 to +4.

Adjusting Monochrome

When the Picture Style (p.49) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering, or with a look
of monotone color photograph.

Select [Monochrome] in the [Picture Style] list box.

Picture Style [~ Reverts the image to

SR the orginal setings

Gamma adjustment A

B Linear
5.0 =40 -20 00 20 40
v

Displays the values of
the settings
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Filter effect: Creates a monochrome photograph where the white of
clouds and the green of trees are emphasized.

Filter Example of effect
None General monochrome image without filter effect.
Yellow Blue sky is reproduced more naturally and white

clouds emerge clearly.

Blue sky becomes somewhat darker. The

Orange brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: Creates a monochrome photograph to which a single
color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

ALy

== Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider to the right.

Adjusting Dynamic Range
Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Y (Standard) -

Move downwards
Output white points

Move to the left or right
Input white points

; T Move to the left or right
/ Mid (medium tone) point
e — : : : -+— Move upwards

= 0.0 0.00 Output black points

I{ B ]

Alr
Ak

You can also adjust
the dynamic range by

00 "
entering values

0o
0o
0o
0.0

AR ArRArEAERAL

Move to the left or right
Input black points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Checkmark the [Move midpoint to match] checkbox to link the
mid-point to your adjustments to the input white points and input
black points.
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A/

=< [Linear] - A function for advanced adjustment

Use [Linear] when you adjust images using image editing software that
has advanced editing functions. Note that when [Linear] is
checkmarked, the image becomes dim.

@ [Contrast], [Highlight], [Shadow], and [Auto Lighting Optimizer]
(p.58) will not function when [Linear] is checkmarked.

Adjusting Gradation and Luminance Automatically

In order to give the image desirable gradations and luminance,
automatic adjustments are applied for an appropriate dynamic range.

Click the [Auto] button.

In order to give the image desirable gradations and luminance,
the dynamic range is automatically adjusted.

White points, midpoint, and black points in the [Gamma
adjustment] panel as well as [Highlight] and [Shadow] in the
[Advanced] panel are adjusted automatically.
Settings that are reset and those that are not with this adjustment
are as follows.
Settings that are reset
* Auto Lighting Optimizer
* [Contrast] in the [Advanced] panel
Settings that are not reset
* Brightness adjustment
» White balance adjustment
* Linear”
* White points and black points are automatically adjusted.

@ An image may look unnatural after automatic adjustment. In such a
case, reduce the degree of shadow and highlight adjustment.

Introduction/
Contents

S ——

Downloading
Images

S

Viewing
Images

—_—

Sorting
Images

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

|

Playing Back
Movies and Saving

Still Photos

HDR PQ
Mode

_—

Specifying
Preferences




Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more favorable image.

You can also change the setting of the image shot with the camera’s
Auto Lighting Optimizer function.

This function also can be used for JPEG/TIFF images in addition to
RAW images.

* ALO stands for Auto Lighting Optimizer.

Checkmark the [Auto Lighting Optimizer] checkbox.

&uto Lighting Optimizer

Checkmark

Standard Strong

For the image shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the setting according to your preferences.
Auto Lighting Optimizer

Select from three
levels: Low/Standard/
Strong

Auto correction is applied to the image to match the setting.
For the image shot with the camera’s Auto Lighting Optimizer
function, the setting at the time of shooting is applied as the
default value.

To cancel the Auto Lighting Optimizer, remove the check mark
from the checkbox.

—

Loy Standard

@ When [Highlight tone priority] is set to [Enable] on any supported
EOS camera other than the EOS-1D Mark IV, or EOS 5D Mark II,
the Auto Lighting Optimizer cannot be used for RAW images.
You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created with the camera.

When you apply Auto Lighting Optimizer to the RAW and JPEG
images shot simultaneously, the correction results of the two
images may differ.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].

[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting value), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting value), the more the image’s edges
are emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the easier it becomes to emphasize fine
details.

[Threshold]:  Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

@ [Unsharp mask] cannot be used with images other than RAW
images.

Select [Sharpness] from the list box and adjust the
setting.

Ficture Style [~ Reverts the image to

SEER| the original settings

Gamma adjustment b

50 -40 -20 00

Select [Sharpness]

Enter a setting (in
0.1-stop increments)

Drag the slider left or right

The adjustment range is 0 to 10.
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Detailed Setting of Image Sharpness
Select [Unsharp mask] from the list box and adjust
the setting.

Pictu ¢le I"‘\

ﬂ (Standard) o Browsze. .

Gamma adjustment %A

B Lincar

10 50 40 20 00 20 40

Select [Unsharp mask]

Fineness Enter a setting (in

Threshold 0.1-stop increments)
Drag the slider left
or right

@ Adjust image sharpness with the window view set to [400%], [200%]
or [100%)]. If the view is set to [Fit to window] (full view), you may not
be able to correctly check the adjustment results.
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JPEG/TIFF

Editing with the Tone Adjustment Tool Palette

With the Tone Adjustment tool palette, you can adjust images with the
same functions as general image editing software.

Select an image in the main window, etc.

Display the Tone Adjustment tool palette.

Tool palette

Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted. Since the
adjustment range is broader than the same functions in the Basic

Adjustment tool palette, the image color may be saturated, or the image

quality may deteriorate if you adjust too much. Be especially careful

when adjusting.

]

Reverts the image to
the original settings

— Drag the sliders left or
right
—Enter a setting (in

0.1-stop increments)
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Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.

Contrast: Used to adjust modulation and degree of contrast
of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

@ The adjustment range is —100 to +100 (in 0.1-stop increments when
entering a value).

Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[lE@] button.

] .9 A iz

Lztment | 4=,
® Lumirance R G B

Ciontrast
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Click on a point that is to be the standard for white.

Click
The coordinates of the cursor position and
the RGB values (8-bit conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click

the [[El}] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ The histogram display changes according to adjustment. You can
also display the histogram before making any adjustments.

Adjusting Tone Curve

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.162).

Select the tone curve mode and interpolation
method.
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Make adjustments.

Tore curve adjustment

. Luminance R G B

. Straight

ra

=

'—‘r—

A

RGB: Adjusts RGB
in a batch

R, G, B: Adjusts
each channel

You can display pre-
and post-adjustment
histograms

Coordinates of [[]
(when several
coordinates are set,
coordinates of last-
set [[])

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[J] is 8.

To delete a [[], either press the <Del> key or double-click on the [[1].

Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones sharper

Makes tones softer
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JPEG/TIFF

Editing with the Color Adjustment Tool Palette

Editing with the Color Adjustment Tool Palette

With the Color Adjustment tool palette, you can adjust the hue,
saturation and luminance in a specific color gamut for 8 color gamuts
(red, orange, yellow, green, aqua, blue, purple and magenta). You can
also adjust the hue and saturation for the entire image and tune
monochrome images.

Select an image in the main window, etc.

Display the Color Adjustment tool palette.

Color adjustment

Hue

Saturation

Orange

|4,

e lloww

|4~

@ The adjustment ranges are as follows:

H: —20 to +20
S: —10to +10
L: —10to +10

Adjusting a Specific Color Gamut
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.

H: Adjusts the hue.

S: Adjusts the saturation.

L: Adjusts the luminosity.

Revert all adjustments to
the original settings

Drag the sliders left

or right

Enter the values to set

Revert color gamut
adjustments to the

original settings
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Adjusting Hue and Saturation for an Entire
Image
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.

Hue: Move the slider to the right to make color tones more

yellowish, and to the left to make color tones more reddish.

Saturation: Adjusts the overall color intensity for the image. Move the
slider to the right for more intense colors, and to the left for
less intense colors.

Color adjustment Revert all adeStmentS

e to the original settings

Saturation Enter the Va|ueS tO Set
Drag the sliders left or
right

I

Orange

|

Yellow

|

@ The adjustment range for hue is —30 to +30; and for saturation is 0
to 200.

Adjusting in Monochrome

Press the [Monochrome] button to set the 8 color gamuts to their least
saturation (-10) and create a monochrome image. After creating it, you
can tune the monochrome image with the H and L sliders for each color
gamut, adjusting the hue and brightness.

Drag the sliders left or

right

Color adjustment Revert all adjustments
" to the original settings

Saturation . — m Enter the values to set

Monochrome

LY

Oranege

I~

‘e low

I~
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H'H H H H Introduction/
Editing with the Detailed Adjustment Tool Palette Contents
You can use the Detailed Adjustment tool palette to reduce the noise . . —
that occurs in images shot at night or at high ISO settings. This tool Reducmg Noise Downloading
palette can also be used in conjunction with the sharpness adjustment . . . . . . Images

. . A . You can reduce noise that arises in images shot at night or with a high
functions. Note that you can use the functions in this tool palette with -]
. . ISO speed.
JPEG and TIFF images as well as RAW images. . . .
NR stands for Noise Reduction. Viewing
. . . . Images
Select an image in the main window, etc. Adjust an image.

Sorting
Images

Display the Detailed Adjustment tool palette.

Tool palette Enlargement
display
position
; Printing
Check window Images
Processing
Large Numbers
of RAW Images
Maize reduction
Reduce luminance petes Drag the sliders Remote
r . Shooting
Reduce chroqpmance noise Enter a Settlng (ln S —
_ L : 0.1-stop increments) Playing Back
== Movies and Saving
- e You can set a noise reduction level from within a range of 0 to 20. Still Photos
Reduce chrominance noise - The larger the setting, the larger the noise reduction effect.
[ ———— : . . .
B R - The noise reduction effect can also be checked in the check HDR PQ
—_— window. Mode
—
Sharphess | 4=
ot ones
. nenarh mas M Preferences
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Y
=)= Setting the same noise reduction level for several images

You can set the same noise reduction level for several images by first
selecting multiple images in the main window, and then adjusting the
noise reduction level using the [Reduce luminance noise] and [Reduce
chrominance noise] sliders.

@ If [Reduce luminance noise] is set, resolution may be reduced
along with reduction of noise.
If [Reduce chrominance noise] is set, color bleeding may occur
along with reduction of noise.

Adjusting Image Sharpness

You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in
“Editing with the Basic Adjustment Tool Palette” (p.59).

Reducing Color Moiré in an Image

You can reduce color moiré* occurring in an image.

*Color moiré: Occurrence of a color appearing that is not originally in an
image. In particular, tends to occur when taking photos of latticed or
similar patterns.

Checkmark the [Reduce color moiré] checkbox and
adjust using the slider.

Moize reduction

Feduce luminance noise

— =

Reduce chraminance noise

—— o

Reduce color mairé

_

Depending on the subject, you may not be able to correct color
moiré completely.

Using this function may cause hue to change depending on the
subject. If there is a noticeable change in hue, lower the level of

adjustment.

Introduction/
Contents

S ——

Downloading
Images

T

Viewing
Images

—_—

Sorting
Images

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

|

Playing Back
Movies and Saving

Still Photos

HDR PQ
Mode

_—

Specifying
Preferences




JPEG/TIFF

Editing with the Trimming/Angle Adjustment Tool Palette

You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before cropping.

Select the image to be cropped.
Display the Trimming/Angle Adjustment tool palette.

You cannot make adjustments with the Trimming/Angle
Adjustment tool palette in a window that only shows thumbnails.

Adjust the angle of the image as needed.

Trimming/angle adjustment window

Largest possible
trimming range

Drag (0.01-degree increments; adjustment range: —45 to +45
degrees)

Use the mouse (click A/V¥)to adjust the angle or directly enter
the adjustment angle (0.01-degree increments; adjustable
range: —45 to +45 degrees)

If you click [Center on Screen], you can display the trimming
range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the

image.

If you have only adjusted the angle of the image, the image will
be cropped at the largest possible trimming range.

Select a ratio and drag the trimming range.

The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

@ When aspect ratio information is attached to an image shot with any
supported camera other than the EOS 5D Mark I, the displayed
trimming range is based on the aspect ratio information.

Select a trimming ratio
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List of aspect ratios (width : height)
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[Free]:

You can crop an image to any size, regardless of
the selectable ratio.
[Custom]: You can crop an image at the specified ratio.

Return to the main window.
The trimming range frame is displayed in the cropped image
(p.161).
When the cropped image is displayed in a preview window or the
edit image window, it is displayed in its cropped form.

? Cropped images

The trimmed range can be reverted to its original condition at

any time

A cropped image is displayed or printed as a cropped image.

However, since the image is not actually cropped, you can always

revert to the original image by clicking the [ [ lka3l] button in the

trimming/angle adjustment window or performing the “Re-Editing an

Image” procedure (p.95).

Display of the cropped image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.161).

* Preview window:  The image is displayed in its cropped condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the preview window display.

Printing a cropped image
You can print as a cropped image by printing it in DPP.

The image becomes a cropped image when converted and saved
The cropped RAW image actually becomes a cropped image when
converted to a JPEG or TIFF image and saved (p.93).

Images that have aspect ratio set will be displayed as cropped
images

When aspect ratio or cropping information is attached to a RAW
image shot with any supported camera other than the EOS 5D Mark
I, the image will be displayed with the set trimming range based on
the information. Since the image is not actually cropped, you can
change the trimming range or revert to its condition before cropping.
However, when a JPEG image is shot either with an aspect ratio set
with a camera that supports aspect ratio information or with the EOS
5DS/EQOS 5DS R set to crop shooting, its trimming range cannot be
changed or the image cannot be reverted to its condition before
cropping since the image is actually cropped and saved.*

When reverting to the trimming range that is based on the aspect ratio
information at the time of shooting, click the [ [ Ea3] button. Also, if
you want to cancel all the trimming range, click the [Clear] button.
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* When shooting with EOS 5DS/EOS 5DS R, EOS 5D Mark 1V,
EOS 5D Mark Ill, EOS R/RP (with any setting other than
[1.6x (crop)]), or EOS 7D Mark Il and [Add cropping information]
is set in Custom Functions, aspect ratio information is only set and
the image is not actually cropped, even for JPEG images.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
cropped image in the main window together with the images to which
you want to apply the trimming range and then display the Trimming/
Angle Adjustment tool palette. With the cropped image displayed,
click the [Copy] button and then click the [Paste] button. This will
apply the trimming range to all the images selected when the
trimming/angle adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window.
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Editing with the Lens Correction Tool Palette

With the Lens Correction tool palette, you can use the lens aberration
correction functions and the Digital Lens Optimizer to correct lens
aberration in your images and to improve their resolution. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that the lens aberration correction functions and the
Digital Lens Optimizer can only be used with RAW images.

Select an image in the main window, etc.

Display the Lens Correction tool palette.

M Distortion

Shot settines

Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

You can only correct aberration in RAW images which have been shot
with compatible lenses. JPEG or TIFF images cannot be corrected.
Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D30, EOS D60, EOS 350D, and EOS 300D are EOS cameras
supporting the Digital Photo Professional, they are not compatible with
the lens aberration correction function. Also, note that the lens
aberration correction function is compatible with the EOS 5D with the
firmware version 1.1.1 and the EOS 30D with the firmware version
1.0.6.

@ To use this function, the EOS Lens Registration Tool (version 1.4.20
or later) must be installed.

@ Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window (p.79).
You can also correct RAW images taken with the compatible lens
even when the extender is attached.
You can also correct RAW images shot with EF50mm /2.5
Compact Macro fitted with Life Size Converter EF.
The aberration correction function is not available for images shot
with a lens other than those given under “Compatible Lenses”.
They are therefore not displayed and cannot be used.
The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the five aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions Diffraction

Select an image in the main window.

Display the Lens Correction tool palette and
checkmark the items to be corrected.

Enlargement display section

The image is corrected and redisplayed.
In the main window, the [# ] mark is displayed on the image to
indicate that the lens aberration correction is applied (p.161).

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check and
then checking the enlargement display section in the top of the
window. You can choose from 4 display scales between 1:1 and
1:4 for the enlargement display.

You can lessen the degree of correction by moving the slider to
the left.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF8-15mm f/4L USM Fisheye or EF15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Correction for Fisheye Lenses” (p.75).

For images shot with EF8-15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
[Diffraction correction] corrects only those images shot with a
camera with a diffraction correction function. By checkmarking
this option, images are corrected according to the camera's
diffraction correction function. Note that this function cannot be
used at the same time as the Digital Lens Optimizer.

The adjustment range of distortion correction is either [0 to +100]
or [-20 to +120], depending on the camera model that was used
for shooting. The adjustment range for images shot with a
fisheye lens mounted is [0 to +100] regardless of the camera
model that was used.
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Effects of Distortion Correction for Fisheye Emphasize Distance o _
Lenses This converts the image to an “equidistant projection” style image. Downloading
This projection method preserves distance relationships. Images
Shot settings Equidistant projection displays a distance in the same distance
By selecting this option, only the aberration corrections will be anywhere from the center to the periphery. In particular, when g
performed to correct the optical distortions. shooting a celestial body such as the celestial sphere, same heights Yr:'f;"":g
above the horizon(declination) are captured at the same heights. This 9

method is therefore used in such photography as celestial
photography (star maps, solar path diagrams, etc.).

Sorting
Images

Editing
| 3

L

Printing
Images
Emphasize Linearity La':;:cﬁﬁxggrs
This converts the image to a “central projection” style image. This of RAW Images
projection method is employed for general lenses. . .
Since central projection displays straight lines as straight lines, a Emphasize Periphery Remote
wide-view panoramic image can be obtained by selecting this option. This converts the image to a “stereographic projection” style image. Shooting
However, the periphery is stretched, resulting in decreased resolution. This projection method emphasizes the periphery.
Stereographic projection allows position relationships on a spherical Plaving Back
& ' surface, such as N, S, E, W on a map, to be displayed correctly. It is Moviegan?d et
. / therefore used for world maps and monitoring cameras. Still Photos
By selecting this option, the periphery is stretched and may result in
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Emphasize Center

This converts the image to an “orthographic projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

@When selecting any of the options, [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center], it will yield results similar to that of the selected projection

method. However, the conversion does not really apply a change of

projection method in a strict sense.
Accordingly, be aware that they are not suited for scientific or other
such purposes.

Shooting Distance Information Slider

When correcting RAW images and if shooting distance information has
been saved to the image, the slider is set automatically according to
this shooting distance information. However, if no shooting distance
information is saved to the image, the slider is set automatically to the
right end at infinity position and a [<!>] appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

When correcting RAW images shot with the cameras in the table below,
it is set automatically to the right end at infinity position. You can then
minutely adjust the distance by operating the slider while looking at the
screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark II
EOS-1D EOS-1Ds EOS 5D
EOS 30D EOS 400D -

For RAW images shot with MP-E65mm /2.8 1-5x Macro Photo or
EF50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

The [Shooting distance information] slider is applied to all the
correction items with check marks.

If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.
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Correcting Multiple Images at a Time

You can apply the same corrections to several images by first selecting
multiple images in the main window, and then performing correction
procedures (p.74).

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.97).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.68). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.69).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.55) and/or the color saturation (p.67) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

@ The periphery of the image may be truncated when [Distortion]
correction is made.

Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability or
any deterioration of resolution resulting from diffraction phenomena.
These optical phenomena cannot be corrected under Lens aberration
correction (p.73). Correction is achieved using the designed value of
each lens. You can correct these optical phenomena in RAW images
which have been shot with compatible lenses. JPEG, TIFF, S-RAW, and
M-RAW images cannot be corrected. To use this function, [Lens data] for
the lens used to shoot images first needs to be downloaded to your
computer. Before using the Digital Lens Optimizer, it is recommended

that you set [Sharpness] or [Strength] for [Unsharp mask] for images to O.

Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D30, EOS D60, EOS 350D, and EOS 300D are EOS cameras
supporting the Digital Photo Professional, they are not compatible with
the Digital Lens Optimizer. Also, note that the Digital Lens Optimizer is
compatible with the EOS 5D with the firmware version 1.1.1 and the
EOS 30D with the firmware version 1.0.6.

® To use this function, the EOS Lens Registration Tool (version
1.4.20 or later) must be installed.
The Digital Lens Optimizer is also available for images shot with
an extender attached to a compatible lens.
You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
[Diffraction correction] cannot be used at the same time as the
Digital Lens Optimizer.
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Click the [[ESE] button.

Shocting distance information

Using the Digital Lens Optimizer

Downloading

Images
Check the status of [Lens data] for [Digital Lens —
Optimizer]. Viewing

Images

Shoeting distance information

Sorting

The [Add or Remove lens data] window appears. igSs

[Not Available] is displayed for an image shot with a non- -
compatible camera or lens, or for a non-compatible image such m:ggg
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images. p :

o . rocessing
If [No] is displayed, proceed to step 2. To use the function, you Large Numbers
need to download the lens data for the lens used when shooting of RAW Images
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked Remote
using the image information and shooting information displays. gibotis

S —

You can also check it with the menu that appears when you right-
click with the mouse on an image.
If [Yes] is displayed, proceed to step 4. Still Photos

Playing Back
Movies and Saving

HDR PQ
Mode

_—

®To use this function, an environment with Internet access Specifying
(subscription to a provider, and an in-place line connection) is Preferences
required. Internet Service Provider (ISP) connection fees or access —

point connection fees may apply. @ @

@ Before you click the [|jifSll] button in step 2, Lens data [No] may @,
be displayed instead of [Not Available] for non-compatible images. S—




Checkmark the checkbox for the lens used to shoot Checkmark the [Digital Lens Optimizer] checkbox
the image, and click the [Start] button. and adjust the image.
0 Add or Remove lens data (Version 1.8.20) “
Se‘UTtrI:nvng:t::dD:v}\:ida Macro EF-M
Standard and medium telephoto Zoom TS-E
Telephoto EF-3 Select all Glear all
Extender EF14% EF2X []L lenses only

[] EF20-35mm 1/25-45 USM ~
[] EF24-70mm 1/28L L USM

[] EF24-70mm 128 USM

[] EF24-70mm 1/4L 15 USM

] EE?l—ﬁmmi F_AF |I1Shi

EF24-106mm £/35-5 6 IS STM

uuuu

[] EF28-70mm £/28L LSM

[] EF28-90mm 1/4-5.5 LT

[ ] EF28-30mm 1/4-5.5 II

[T] EF28-90mm 1/4-5.8 LI LSM
[] EF28-105mm £/35-15 USM
[] EF28-105mm £/35-45 I USM
[ EF28-108mm £/4-56

[C] EF28-108mm f/4-5.5 LISM

[C] EF28-136mm §/35-56 IS LISM
[C] EF28-200mm §/35-5 6

(] EF28-200mm /3556 LUSM
[] EF28-300mm £/45-56L 1S LISM
[ ] EF55-200mm £/45-56 T LSM
[ ] EF55-200mm £/45-56 USM
[ FEIN-20Nmm £7981 15 T 1ISM

Destination Folder . Add:1 7 Delete:0 ' Start ' Gancel

Nate & Lens data : Yes
Digital Lens Optimizer Reverts to its condition
before adjustment

Shooting distance information

]

The lens data is downloaded to your computer.

When the downloading of the lens data ends, the indication for
the lens data changes to [Yes].

Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window.

If you remove the check mark from the checkbox for already-
downloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.

®Since the lens data downloaded with DPP version 3.x is not
compatible with DPP version 4.x, the lens data must be downloaded

again.
Depending on the type, current state, etc. of software running on @ When applying the Digital Lens Optimizer, the effect of [Sharpness]
your computer, the download of the lens data may fail. If it occurs, or [Unsharp mask] may become excessive. It is recommended that
wait for a while then try downloading the data again. you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0
If you want to change the destination where lens data is saved when before using the Digital Lens Optimizer. Adjust [Sharpness] or
there is already downloaded lens data, move the previously downloaded [Unsharp mask] again after applying the Digital Lens Optimizer to
lens data from the old folder to the new destination folder manually. images.
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Use the slider to adjust the Digital Lens Optimizer effect. —
If no shooting distance information is saved to the image, the Downloading
shooting distance slider is set automatically to the right end at Images
infinity position and a [<!>] appears above the shooting distance e
slider. Viewing
If the lens requires no adjustment with the [Shooting distance Images
information] slider, the slider cannot be used. R
Images cannot be corrected for [Chromatic aberration] in the lens Sorting
aberration correction tool pallet if the Digital Lens Optimizer has Images
been applied.

In the main window, the [ﬁ] mark is displayed on the image to
indicate that the Digital Lens Optimizer is applied (p.161).

Adjusting Image Sharpness 732323

You can also use this palette to adjust the image sharpness. For Processing
information on making adjustments, see “Adjusting Image Sharpness” in Large Numbers
“Editing with the Basic Adjustment Tool Palette” (p.59). of RAW Images
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Editing with the Partial Adjustment Tool Palette

The Partial Adjustment tool palette adjusts the selected area of an

image.

With this tool palette, you can adjust brightness, contrast, hue, and

saturation, and reduce color moiré.
Supported image formats are CR2, CR3, TIFF, and JPG.

@ On 32-bit OSs, this function is not available.

Making Partial Adjustments to Images
([Brightness], [Contrast], [Hue], [Saturation])

Select an image in the main window, etc.

Display the Partial Adjustment tool palette.

Tool palette

Size
. ———
Blur radius

—— =

Adjustment eroup

Erightr
e [ e

Contrast

—— =

Hue

Saturation

—— =

Select [Adjustment group].

Adjuztment eroup

Contrast

—— I

Hue

Saturation

—_— E

Select [Adjustment group] from (K], [HEN]. (HEM]. [IEM]. and
().

(By default, [[JE] is selected.)

For information on adjustment groups, see “Adjustment Groups’

(p.84).

Click the [Set Adjustment Area] button.

Set Adjustment Area

I

Sz

*

Blur radius

*

A circular cursor appears in the window.

Introduction/
Contents

|

Downloading
Images

|

Viewing
Images

|

Sorting
Images

J

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

|

Playing Back
Movies and Saving

Still Photos

HDR PQ
Mode

_—

Specifying
Preferences




Cuztom

Circular cursor

Drag the sliders to adjust [Size] and [Blur radius] for

the circular cursor.

Set Adjustment frea

[
(]

Size

*
Blur radius

. —

[Blur radius] adjusts blurring at the border of the selected area.

Click or drag the circular cursor on the image to
select the area of adjustment in the image.

Use the sliders to adjust [Adjustment items] as
necessary.

fdjustment eroup

Brightnezz

——— =

Caontrast

—— e

Hue

Saturation

—_——

Adjustments are applied to the area selected in step 6.

You can use the ||, [(IESEN]. (IE3]. and [IETHN]
buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All].
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Making Partial Adjustments to Images Downloading
(IReduce color moiré]) Images

This function partially reduces color moiré in images. -
Before making adjustments, see “Reducing Color Moiré in an Image” Viewing

. . . - Images
(p.69) for information on reducing color moiré.

Changes edited with this function are not displayed in the
following images.
* Thumbnail images
* Navigator images
* Images in the HDR [Select images] window (see p.108, step 3)
* Images in the [Contact sheet] window for printing a thumbnail
list (see p.124, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
Changes edited with this function are not applied in the DPP
histogram display.

Select an image in the main window, etc.
Display the Partial Adjustment tool palette.

Click the [Reduce color moiré] button in [Adjustment
group].

A dialog box for [Reduce color moiré] appears.

Click the [Set Adjustment Area] button, and use the
[Size] and [Blur radius] sliders for the circular cursor
to make adjustments.

Click or drag the circular cursor on the image to
select the area of adjustment in the image.

Use the [Reduce color moiré] slider in [Adjustment
items] to specify the setting.
Adjustments are applied to the area selected in step 5.

You can use the ||, [(IESEN]. (3], and [IETHN]
buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All].
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Changes edited with this function are not displayed in the
following images.
* Thumbnail images
* Navigator images
* Images in the HDR [Select images] window (see p.108, step 3)
* Images in the [Contact sheet] window for printing a thumbnail
list (see p.124, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
Changes edited with this function are not applied in the DPP
histogram display.

Adjustment Groups

Adjuztment group

[ Feduce color mairé

The Partial Adjustment tool palette comprises 5 adjustment groups

that allow adjustments to be made with [Brightness], [Contrast], [Hue],

and [Saturation] options, and 1 adjustment group that allows

adjustments to be made with the [Reduce color moiré] option.

+ A different adjustment area can be selected for each adjustment
group.

» Adjustment groups [IER]. [(IER]. [IER]. [IEW]. and [[IEE] allow
different values to be specified even for a same adjustment option.

By default, adjustments from all adjustment groups are applied to an

image. However, you can click the [[F] button and select to apply or

not apply adjustments from each adjustment group.

Positions selected with the circular cursor, that can be checked using

the [IIESSN], (IES], (MR, and [IEETEN] buttons below

[Adjustment items], can be checked per each group.

The order of adjustment groups in which adjustments are applied to

images is (1) [Reduce color moiré], (2) [IER]. (3) [IER]. (4) [IEW],

(5) (M), and (6) [NEM]-
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JPEG/TIFF

Editing with the Dust Delete/Copy Stamp Tool Palette

You can use this tool palette to erase dust and other marks in a shot
image and to correct an image by copying part of the image and pasting
it onto an unnecessary part of the image.

Note that you can use the functions in this tool palette with JPEG and
TIFF images as well as RAW images.

Dust Delete/Copy Stamp Tool Palette

Tool palette

® On 32-bit OSs, the results of erasing dust manually (repair
function) (p.87) and erasing unwanted parts of an image (copy
stamp function) (p.89) can only be checked in the window in which
erasure was performed, in the print results, or in the image after
being converted and saved.

&pply Dust Delete Data

(Diark)

Performing Automatic Dust Erasure Processing
The Dust Delete Data that is appended to images can be used to
automatically erase dust spots.

Select an image with dust delete data attached in the
main window, etc.
Display the Dust Delete/Copy Stamp tool palette.

You cannot make adjustments with the Dust Delete/Copy Stamp
tool palette in a window that only shows thumbnails.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

Dust spots are erased in a single operation.

Return to the main window.
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ Ea3] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.95).

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.87) or the copy stamp function (p.89).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.93).

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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) ] ] Place the dust spot to be erased within the [O] and
Manually Erasing Dust (Repair Function) click. P =

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image from which you
want to erase dust spots.

Display the Dust Delete/Copy Stamp tool palette.

Click the point from where dust is to be erased.

Click

The dust spot within the [O] is erased.

Click on another part of the image to continue erasing dust spots
within the displayed image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [@] is displayed.

Click

_ _ Return to the main window.
The display changes to 100% view.

The display position can be changed by dragging.
Click the button that matches the dust spot to be

erased.
If the dust spot is dark in color, click the [ Dark) ] button,
and if the dust spot is light in color, click the [ TN |
button.

When you move the cursor over the image, the dust erasure
range is indicated with [O].
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.89).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ [ Ez38] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.95).

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.93).

Ny

=< Useful functions of the copy stamp window

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.
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Erasing Unwanted Parts of an Image (Copy Stamp Function) Downloading

You can correct an image by pasting a section copied from another part Images
of the image to an unwanted part of the image.

. ] ] Viewing
Follow steps 1 to 3 in “Manually Erasing Dust (Repair Images

Function)” (p.87).

Specify the section to be copied. f’n‘l’;tg'lgg
Click on the section that is to be the copy source after clicking the
[Select Copy Source] button.

To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy

Source position]. Printing
Images
Correct the image.
Click or drag on the part of the image you want to modify. [+] in Processing
. . S Large Numbers
the v.vmd.ow indicates the copy source and [Q] indicates the copy of RAW Images
destination.
The copied image is pasted in the position to which it was Remote
dragged. Shooting
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s Playing Back
borders are sharp). Movies and Saving
. . Still Photos
Return to the main window.
HDR PQ
Mode
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Setting Work Color Space

A different work color space (p.163) from the default settings (p.155) can
be set for each image.

Display the Settings tool palette » select the color
space to be set.

Settings tool palette

Toal pa lette

HOR P2
0 Off

‘Work color space

Soft-proof colors

Settings..

. gitmulation profile

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.155), this
default setting will not be applied and the individually set color space will
remain.

-:@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Using the Soft-Proof Colors Function

By using the soft-proof colors function, you can apply a selected printing
profile or CMYK simulation profile to the displayed image. The reliability
of the soft-proof colors function depends on the monitor quality, the
monitor and printer profiles, and surrounding lighting conditions where

you are working.

Click the [Settings] button.

Toal te X

The [Color management] tab sheet in [Preferences] appears.

Select the profile to apply from the [Printing profile]
or [CMYK simulation profile] list box, and click the

[OK] button.

Preferences

Default settings of Work. color space
® sRGE O Arple RGE

) Adobe RGB O ColorMateh RGB
) Wide Gamut RGB

[ Use shasting color space as mork ealor space

Golar

For display

GMYK simulation profile

[ MNore — -]

#Changes take effect after restarting

Cancel

The [Color management] tab sheet in [Preferences] closes.

According to the profile selected in step 2, select
either [Use printing profile] or [Use CMYK simulation
profile], and checkmark the [Soft-proof colors]

checkbox.

Profile :

OO
(o ]

The profile selected in step 2 is applied to the displayed image

including its thumbnail.

The profile is not applied to images displayed in the quick check

window.
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Specifying the Size when Opening RAW Images

This applies only to RAW images with the extension “.CR3” that were
shot with [ cam ] selected on the camera.

This function specifies the image size when a RAW image is selected
and opened in DPP. When the selected RAW image is converted and
saved as a JPEG or TIFF image, it is also saved at the same size.
This function is not available for images shot with the Dual Pixel RAW
function set on the camera.

Select the RAW image » display the Settings tool
palette » select the size when opening RAW images
in DPP.

Settings tool palette

ation profile

=n opening RAW images

Original zize (do not chanee) -

The image size when opening RAW images in DPP is set.

The default setting shows the size set in [Default size when
opening RAW images] in the [Image Processing 2] tab sheet in
[Preferences].

The settings are saved as recipes for each image.
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JPEG/TIFF

Saving Editing Results

Saving Editing Contents to an Image

All the contents adjusted with the tool palette (recipe) can be saved to
the image or saved as a separate image.

Select the [File] menu » desired item.

Close window Ctrl+W
Save Ctrl+S
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D
Batch process... Ctrl+B

Save still image from movie..  Ctrl+5Shift+D

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+Shift+G

Clear collection

Select collection 3
Delete collection 3
Bookmark

Remove bockmark

Maove to Recycle Bin Del

Exit Alt+F4

Your adjustments are saved to the image.

Saving as a separate image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

If a JPEG or TIFF image is saved as described below, the image can be
saved as a separate image with the adjustments (recipe) applied to it.
The image is saved as a separate image, so the original image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Close window Ctrl+W
Save Ctrl+5
Save As... Ctrl+Shift+3
Convert and save... Ctrl+D ]
Batch process... Ctrl+B

Save still image from movie..  Ctrl+5hift+D

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Rermowve from collection Ctrl+Shift+G

Clear collection

Select collection 3
Delete collection 3
Bookmark

Remove bockmark

Maove to Recycle Bin Del

Exit Alt+F4

The [Convert and save] window appears.
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Specify the necessary settings, and then click the

[Save] button.
By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.
Change the settings according to your requirements.

@ Convert and save E
sove nffl || oooce 03 v @3 = m-
33
Recent places
— m — Select the save
g I destination
=
Libraries
LY
This PC
- File name [G_0007 v [ s | J— CI|Ck and save
,_%_‘_ [‘Saveesswe TIFF 16bit + Exif-JPEG (*TIF, ¥JPG) V]LL'M'_)

Cutput setting

Enter a file name
and select an
image type

Imsge quality 10
Output resolution 350 dpi

[] Resize |
Width Height
6472 x 3648 (5472 pixel x 3648 pixel) Unit [pixel
Embed I0G profile

Shoating infa setting  Include all shooting info

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

|
\\/

:@3 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, saving the image as a separate file (p.93)
is recommended.

@ By saving as a separate JPEG or TIFF image as explained
above, some image deterioration that accompanies editing/saving
occurs as when editing with general image editing software.

By saving as explained above, a trimmed image (p.70) or dust-
erased image (p.85 to p.89) actually becomes a trimmed image
or dust-erased image.

You can batch convert and save multiple images (p.129).
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.45 to p.90), so the “original image data itself’
remains unaffected. (The trimming range or dust-erasure information of
a cropped image (p.70) or dust-erased image (p.85 to p.89) is simply
saved to the image.)

For this reason, you can undo any adjustments saved (p.93) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data

Work color space »

Revert to last saved settings  Ctrl+Alt+Z
Revert to shot settings Ctrl+Shift+Z

The image reverts to the conditions of the selected item.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.dr4”) and loaded and
applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

JPEG, TIFF image data |
Image processing conditions information

, . RAW i lmage data:
Image processmg conditions information

I \N
L.drd ]

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.dr4”).

A recipe file with contents that can only be adjusted in RAW
images are not reflected even if it is applied to a JPEG or TIFF
image.

Recipes are not compatible between DPP version 4.x and DPP
version 1.x to 3.x. Images with DPP version 1.x to 3.x recipe files
attached are displayed with the shot settings in DPP version 4.x.
Conversely, images with DPP version 4.x recipe files attached are
displayed with the shot settings in DPP version 1.x to 3.x.
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Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image.

Select the image with the recipe you want to copy.

To copy all items of a recipe, select the [Edit] menu »
[Copy recipe]. To copy only selected items of a
recipe, select the [Edit] menu » [Copy selected
recipe].

The recipe is copied.

To select recipe items, select the [Edit] menu P [Select and copy

recipe settings] and select items in the window that appears.

After specifying settings, click the [OK] button and close the
window.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe].
The recipe is applied to the image.

@ When a recipe for an image is copied and applied to an image
in a different orientation, the image orientation also changes.
To prevent the orientation of the image from changing, select the
[Edit] menu » [Select and copy recipe settings] and remove the
check mark from the [Rotate left / Rotate right: 0°] checkbox in
the window that appears.

Saving a Recipe as a File

Select an edited image, and then select the [Edit]
menu » [Save recipe in file].

The [Save recipe in file] dialog box appears.

To save all of a recipe, select the [Save all recipes] option in the
window displayed.

To select and save recipe settings, select the [Save selected
recipes] option in the window displayed and then click the
[Specify Recipe Details] button. In the window displayed,
checkmark the recipe settings to be saved and then click the
[OK] button.

Select the destination folder, enter a file name, and
then click the [Save] button.
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Loading and Applying Recipes

Select the image to which a recipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select a recipe and click the [Open] button.
The recipe is applied to the image.
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JPEG/TIFF

Adjusting by Comparing Multiple Images

You can synchronize the areas in different images to be displayed
among multiple preview windows, and adjust images while comparing
them.

In the preview window, display the multiple images
to be compared.

Align the images.
Select the [Window] menu » [Arrange horizontally] or [Arrange
vertically].
The preview windows are aligned.

Select the [Preview] menu » [Sync preview position]
and [Sync preview display size].

Enlarge the image.
Enlarge and display any of the preview windows.

Other preview windows will also be displayed in the same
position/enlargement ratio.

Move the area to be displayed.
If you move the enlargement display area in one of the preview
windows, the enlargement display area will also change in all
other preview windows.
To cancel synchronization, select the [Preview] menu » [Sync
preview position] and [Sync preview display size] again.

@ Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not

synchronized.
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Editing Efficiently

Editing in the Edit Image Window

The thumbnail display and the preview window are combined, and
images can be edited efficiently while quickly switching between images
to be edited. Select the images to be edited beforehand in the main
window.

In the main window, select the images you want to
edit.

Switch to the edit image window.

@ Digital Photo Professional 4 - [Folder: C:\Users\xood Desktop\xoooo_03]

File Edit View Thumbpails Preview Label Adjustment Tools Window Help

Edit Irmage ck Remote Shooting

Filter ON OFF o'

Click
The main window switches to the edit image window.

Edit image window

1]

3

T i ] e

Edit the image.

Change the display magnification

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.161).

The tool palettes, navigator palette, and histogram palette are
displayed and you can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.
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Click the area you want to enlarge.

Click

The area you clicked is enlarged to 100% (actual pixel size).
To change the display area, drag on the image or drag the
enlargement display area (p.19) of the navigator palette.
Click again to revert to the full view ([Fit to window]).

To return to the main window, click the [] button on the
toolbar.

@ With the edit image window, you can only select images from a
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.102).

Changing the Thumbnail Display Position to Horizontal
Select the [View] menu » [Horizontal Thumbnails].

If you select [Vertical Thumbnails], the thumbnail display reverts
to the vertical position.
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Gathering and Editing Images in the Collection Window

You can gather selected images together in Collection folders for
viewing, comparison and editing.

You can gather images from several folders as well as from a single
folder, allowing you to work with them efficiently.

Click [+ Add collection] in the [Collection] area in the
main window.

15

[ R IMG_0019.CR2

Gollection

A new collection folder is created in the [Collection] area.
Enter a name for the collection folder.

To create additional collection folders, repeat the operation. Up to
20 folders can be created.

Select the [File] Menu » [Select collection], and
select a collection folder to gather images from the
collection folder names displayed.

Select images or image folders in the main window.
Select the [File] menu » [Add to collection].
The images are added to the selected collection folder, and the
number of selected images in the collection folder is displayed.
When an image set to single-image display (p.23) is added, the
number of images is indicated as two images.
You can also add images to a collection folder by selecting
images and folders and then selecting [Add to collection] from
the menu that appears when you right-click the mouse.

Select a collection folder in the [Collection] area.

@

LR ] IMG_0019.CR2

Collection

@

3 0001(35)
B 000201) o IMG_0027.CR2

3 000325)
(O =l (3

Images in the selected folder are displayed.
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Check the displayed images.

Edit the images.
Edit the displayed images.

Displayed images are retained in the collection folders even after

exiting DPP.

® On 32-bit OSs, only up to 1000 images can be displayed per
collection folder. Starting with the 1001st image, images are handled

in the same way as non-supported images. Try to maintain 1000
images or less per folder.

> To remove images from collection folders

Removing selected images

Select images in a collection folder, select images, and select
[Remove from collection] in the [File] menu. (You can also remove
images from a collection folder by selecting the images, right-clicking
with the mouse, and selecting [Remove from collection] from the
menu that appears.) Note that even if you remove an image from a
collection folder, the original image remains unaffected.

Removing all images

Select [Clear collection] in the [File] menu. Note that even if you
remove all images from a collection folder, the original images remain
unaffected.

Deleting a collection folder

Select a collection folder in the collection area, then select [Delete
collection] from the menu that appears when you right-click with the
mouse. Note that if you delete a collection folder, the original images
remain unaffected.

Modifications to the image are applied to the original image

Modifications made to images in a collection folder are all applied to

the original image.
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Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

® On 32-bit OSs, this function is not available.

@ This function can be used with all image types (p.4) supported by
DPP.
The color space of a composited image will be the color space of
the background image.
Image information is not appended to a composited image.

Select a background image in the main window.

W= 1 > ENTHEN

You can also select a background image from the edit image
window or [Collection] window.

Select the [Tools] menu » [Start Compositing tool].

The compositing tool window appears.

C\Users\sooood\Pictures\ioosod IMG_0001.CR2 [5760 x3840] = E

>
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Select the image to combine.
Select the image to combine from the [Foreground Image]

list box.
-

100%0 view

Foreground Image

IMG_0001.CR2 L

Select an image
IMG_0001.CR2
IMG 0002.CR2
IMG_0003.CR2
IMG_0004.CR2

Composite Method

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and [Foreground

Image] is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window:
images in same folder as background image

* When a background image is selected in the [Collection]
window: images in the [Collection] window

* When a background image is selected in the edit image
window: images displayed in the thumbnail display area

You can also combine images of different sizes.

Select a compositing method.

Select a compositing method from the [Composite Method]

list box.
m—

100%% view

Foreground Image

IMG_0002.CR2 W

Position

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.107).

If you select [Weighted], you can set the proportion of the image
to be combined. Use the [Weight] slider at the bottom of the
[Composite Method] list box or directly enter a value to set the
proportion.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Position the images.

@ C:\Users\wooood\Pictures\oooo\IMG_0001.CR2 [5760 x3840]

o |

Weighted

Compose in RAW Format

Weight

Position

100% view

Foreground Image

IMG_0002.CR2

Composite Method

w

50.0 =

Shift large amount (50 pixels)

Shift small amount (1 pixel)

Align image centers

You can also directly enter the position

Continue

Save As...

coordinates of the [Foreground Image]
to align it.

Close

By default, the background image and the [Foreground Image] are
displayed with their centers aligned.

[Compose in RAW Format]

Checkmark the [Compose in RAW Format] checkbox as necessary.

You can set [Compose in RAW Format] under the following

conditions.

Both the background image and [Foreground Image] are RAW

images, and all the following conditions are met.

» The cameras used to shoot were of the same model

» The ISO speed setting at the time of shooting was the same

» The highlight tone priority setting at the time of shooting was
the same

» The image sizes (original size) are the same

The following functions are not available for images composited
with [Compose in RAW Format].

 Auto Lighting Optimizer (p.58)

* Picture Style Auto (automatically set to Standard) (p.49)
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Click the [Save As] button.

Position

"

4

“

Continue

Save As...

Close

Specify the required settings in the window that appears and then
click the [Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The background image and [Foreground Image] are added and
images are combined.

Average

The background image and the [Foreground Image] are combined in
proportions of 50% each.

If you want to change the proportion of the [Foreground Image], select
[Weighted].

Weighted

Set the proportion of the [Foreground Image] and then combine the
background image and [Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions of the [Foreground Image] being combined.
Darken

The background image and the [Foreground Image] are compared,
with only darker portions of the [Foreground Image] being combined.

@ You can display this function as a function button in the main

window’s toolbar (p.120).
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JPEG/TIFF

Creating HDR (High Dynamic Range) Images

You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures for the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

@ On 32-bit OSs, this function is not available.

@ This function can be used with all image types (p.4) supported by
DPP.
Image information is not appended to an HDR image.

Select an image in the main window.

Select the [Tools] menu » [Start HDR tool].
The [Select Images] window appears.
You can also display the [Select Images] window from the edit
window and edit image window.
Specify the required settings, then click the [Start
HDR] button.

@ Select Images [ = |

IMG_0001.CR2 IMG_0002.CR2 IMG_0003.CR2

Browse... Browse... Browse...

[] Auto Align

e e

To change the selected image or add another image, click the
[Browse] button, and in the [Open] dialog box that appears,
select the image file and click the [Open] button.

If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

By clicking the [Start HDR] button, the [Adjust Image] window
appears.

®After using auto image alignment, the periphery of the images is

partially deleted.
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Make required selections to adjust the image.
) -

@ Adjust Image

Presets
Natural v
Tone/Color
Brightness:(50)

Saturation:(50)

Contrast:(30)

Detall Enhancement
Strength:(0)

Smoothness:(0)

IMG_0001.CR2 / IMG_D002.CR2 | IMG_0003.CR2

Sliders in [Adjust Image] window
[Tone/Color]

[Brightness]: Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.

[Saturation]: Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

[Contrast]: Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]

[Strength]:

Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.

[Fineness]:

Move the slider to the right for a smooth and
natural impression.

Adjusts the clearness of details. Move the slider
to the right for a sharper outline.

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by
default), instead of operating the sliders individually. By selecting
a finishing effect, each slider moves according to the setting. You
can also operate and adjust the sliders after selecting an effect.

[Naturall:

[Art standard]:

[Art vivid]:
[Art bold]:

[Art embossed]:

In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

Gives a finish with painting-like tonality for an
impressive image.

For a more vivid look than with [Art standard].
For a more vivid look than with [Art standard],
that makes the subject pop out.

Tones down vividness more than [Art standard],
for an old-fashioned feel.
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Click the [Save As] button.

Fineness; (0}

Save As...

Close

Specify the required settings in the window that appears by
clicking the [Save As] button and click the [Save] button.

@ You can display this function as a function button in the main
window’s toolbar (p.120).
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Using the Dual Pixel RAW Optimizer

By setting the Dual Pixel RAW function on the camera compatible with
the function before shooting RAW images, images are recorded as
“special RAW images (Dual Pixel RAW images)” with dual pixel
information appended from the imaging sensor. This is called Dual Pixel
RAW shooting. Using this function, the [Dual Pixel RAW Optimizer], with
Dual Pixel RAW images, you can make use of the Dual Pixel data
recorded with the Dual Pixel RAW image for microadjustment of the
position of maximum sharpness and resolution using the depth
information contained within the file, repositioning the viewpoint or
foreground bokeh for a more pleasing result, and reducing the
appearance of ghosting in images.

@Cautions for Dual Pixel RAW shooting
Note the following when shooting in Dual Pixel RAW.
Common to all functions
« Effects are most easily gained when the lens aperture value is
/5.6 or lower.
« Effects may be different between shooting in vertical orientation
and horizontal orientation.
* It is recommended that the ISO speed be ISO 1600 or lower.
Only for “Microadjustment of the position of maximum sharpness
and resolution using the depth information contained within the
Dual Pixel RAW file”
* It is recommended that the lens focal length be at least 50 mm.
* It is recommended that this function be used when the camera
is at a distance from the subject.”
* Use the following as a guide to subject distances according to
focal length.
When the lens focal length is 50 mm, the subject distance
should be approx. 1 m-10m/ 3.3 ft. - 32.8 ft.
When the lens focal length is 100 mm, the subject distance
should be approx. 2 m-20 m /6.6 ft. - 65.6 ft.
When the lens focal length is 200 mm, the subject distance
should be approx. 4 m-40m/13.1 ft. - 131.2 ft.

@ You can display this function as a function button in the main
window’s toolbar (p.120).

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel RAW File

Microadjust the position of maximum sharpness and resolution, using the
depth information contained within the Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

LY C\Users\user\Pictures\xoo0odIMG_0010.CR2 [6720 x 4480] = = “

Checkmark the [Image Microadjustment] checkbox.
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Adjust the image.

& C\Users\user\Pictures\oooed\ IMG_0010.CR2 [6720 x 4480]

Use the slider to adjust the resolution based on depth information
and the level of resolution.

Click the [OK] button.

Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.93).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

This function cannot be used at the same time as “Reposition the
viewpoint or foreground bokeh for a more pleasing result” or
“Reduces the appearance of ghosting in images”.

Reposition the Viewpoint or Foreground
Bokeh for a More Pleasing Result

Reposition the viewpoint or foreground bokeh for a more pleasing resuilt,
using the dual pixel information recorded in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.
Checkmark the [Bokeh Shift] checkbox.

Specify the area to adjust.

@

Ci\Users\user\Pictures\poo0od\IMG_0020.CR2 [6720 x 4480] ~clEl|

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.
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Adjust the image.

@ CA\Users\user\Pictures\xooood IMG_0020.CR2 [6720 x 4480] o B “

Use the slider to adjust the viewpoint.

Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.93).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

Resolution may expand in the depth direction according to the
level of adjustment.

If the border of the selected area in the image appears unnatural,
lower the level of adjustment.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reduces the appearance of ghosting in
images”.

Reduces the Appearance of Ghosting in Images

Reduce the appearance of ghosting in images, using the dual pixel
information in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

Checkmark the [Ghosting Reduction] checkbox, and
specify the area.

e

C:\Users\user\Pictures\ioooo\IMG_0030.CR2 (6720 x 4480] = = “

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.

Any ghosting and flare in the specified area is reduced.
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Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.93).

There may be cases where the subject's outline and any bokeh
look unnatural, or where an increase in noise or noticeable
changes in hue or brightness occur.

There may be cases where the border of the selected area in the
image looks unnatural.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reposition the viewpoint or foreground bokeh
for a more pleasing result”.
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Using Depth Compositing

Depth compositing generates a single image from several images that is
in focus over a wide area. This function combines images with the Depth
Compositing tool, and outputs the combined result as a depth composite
image. It is then possible to also correct the output image using the
Depth Compositing Editing tool.

This function can also be used with images shot without using focus
bracketing on the camera.

See “Cautions when shooting images for depth compositing” (p.116)
and “Cautions for using depth compositing” (p.117).

® On 32-bit OSs, this function is not available.

Supported Images

Cameras EOS 5D Mark IV, EOS R, EOS RP
RF, EF, and EF-S lens groups (excluding TS-E lenses

Lenses and fisheye lenses)
Supported *4
formats CR2, CR3, JPG, TIFF
Shootin The camera, lens, shutter speed, aperture value,

ng focal length, image format, and image size must be
conditions the same

"1 TIFF images converted and saved in DPP

Even if the above conditions are met, the following images are not
supported by depth compositing.

* RAW images created by multiple-exposure shooting

* Images without shooting information

* Images saved as HDR PQ mode display images

* Images of 1600 x 1600 pixels or less, or 9999 x 6666 pixels or more

Using the Depth Compositing Tool
Select multiple images in the main window, etc.

For images shot using focus bracketing on the camera, you can

perform depth compositing even if you select only one image.
Select the [Tools] menu » [Depth Compositing] »
[Start depth compositing tool].

The Depth Compositing tool window appears.
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Adjust and set items as necessary, and then click the
[Execute] button.

Depth Compositing X

Performine depth compoziting from 10 imaees.
Adjust az needed.

Amount of bokeh : {0) '

Specify larger values for subjects with significant bokeh.

‘Weighted toward nearer subjects : (1) '

Specify larger values when nearer and farther subjects overlap.

Smoothhess of compositing boundary : (0) '

Specify larger values to make the compoziting boundary smooth.

Auto brightness adjustment

Cutput file
G Uzers¥ Uzer¥ Desk top¥ o000 ime¥ DO _IMG 03 PG ]

Browse

* A gource image folder will be saved in the same tolder as the output file.

Execute Cancel

Images are combined and a depth composite image is output.
A source image folder (folder name: DPP_DC _...) is output in the
same folder as the depth composite image.

The source image folder is used to correct the depth composite
image with the [Depth Compositing Editing Tool].

To change the output destination or format of a depth composite
image, click the [Browse] button to make the settings in the
window that appears.

[Auto brightness adjustment] suppresses any change in
brightness between images used for depth compositing with
automatic correction when brightnesses are slightly different.

@ You can display this function as a function button in the main

window’s toolbar (p.120).

G cautions when shooting images for depth
compositing

After performing depth compositing, the combined result may
have a narrower angle of view than when images were shot.
When shooting with focus bracketing, shooting with a wider angle
of view is recommended. After depth compositing, you can crop
the image if necessary.
For best results, set the aperture value in a range of f/5.6-11
before shooting.
Be sure to use a tripod and lock the camera firmly in place before
shooting.
Repeating patterns such as lattice patterns and stripe patterns, or
images where the entire screen is flat and lacking contrast may
not be combinable.
When shooting multiple images, start by focusing on the image
nearest to you and work progressively farther away.
When shooting multiple images, images where the focus differs
largely may result in a combined image with uneven focus or that
may not be combinable.
Depth compositing assumes that images of still subjects are
being combined. Images shot of moving subjects may not be
combinable.
If multiple subjects are in the screen, images may not be
combinable depending on how subjects are arranged, for
example, subjects spaced far apart.
The lenses below are recommended.
RF35mm F1.8 MACRO IS STM, RF50mm F1.2 L USM, RF28-
70mm F2 L USM, RF24-105mm F4 L IS USM
EF16-35mm f/4L IS USM, EF24-70mm f/4L IS USM, EF100mm
f/2.8L MACRO IS USM, EF180mm f/3.5L MACRO USM
EF-S35mm /2.8 MACRO IS STM, EF-S60mm /2.8 MACRO
USM
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5 cautions for using depth compositing Using the Depth Compositing Editing Tool

Downloading

When the Depth Compositing tool is started up, the content of If intended results were not obtained with the Depth Compositing tool, Images
recipes that are attached to images in focus is reflected in the this function copies the portion of the image to be corrected from a —
depth composite image (excluding the following items). source image to the depth composite image (in this tool, the [Edited Viewin

° Stamp Image]). Imagesg

* Dust delete data

* Reducing color moiré (Partial Adjustment tool palette)

» Angle adjustment (Trimming/Angle Adjustment tool palette)

+ Size setting when opening selected RAW image in DPP (p.92)

* Color adjustment for a specific color gamut (including
[Monochrome])

 Dual Pixel RAW Optimizer

* Auto Lighting Optimizer

Select the depth composite image in the main
window, etc.

Select the [Tools] menu » [Depth Compositing] »
[Start depth compositing editing tool].
The Depth Compositing Editing tool window appears.

Sorting
Images

* ShadOWS/hlghllghtS @ C:\Users\User\ Desktop\XCO00CO0CCNIMGNDC_IMG_XX/CLIPG (DPP_DC_T) [m] X
The Depth Compositing tool does not start up if an image in focus S
is not supported.

Printing
Images

Edited Image

Processing
Large Numbers
Radiss(95) of RAW Images

Blur radiusi 160)

Remote
Shooting

Select a source image

|

Playing Back
Movies and Saving

Still Photos

HDR PQ
Mode

_—

I+ + /10 »> > [ Close |

Specifying
A thumbnail of the source image is automatically displayed at the Preferences
bottom of the screen. However, thumbnails of source images are R
not automatically displayed if the name of the depth composite

image or the source image folder is changed or the save location @ @
is moved. Select the source image folder that was output at the

same time the depth composite image was output. @;

—
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Select a source image and modify it as necessary.

@ CiAUsers\User\Desktop\XXHOOCCOU mg\DC_IMG_XXXX.JPG (DPP_DC_1) [u]

Source Image Edited Imaee Zoom in 100%

Set Adjustment Area

Radius(35)

v
Elur radiust 160)
)
|4 - Py |
1 |_
Circular cursor
< > Save hs
ey <+ 110 > > Glose

Select a source image from the thumbnails of source images
displayed at the bottom of the screen.

If the [Source Image] and [Edited Image] are shots of different
areas, a black frame may be displayed around the [Source Image].
Clicking the [Set Adjustment Area] button displays a circular cursor.
Click or drag the portion of the [Edited Image] that you want to
correct with the circular cursor, and the same portion of the [Source
Image] is copied.

Use [Radius] to set the size of the adjustment area, and use [Blur
radius] to set blurring at the border of the adjustment area.

You can return through the corrections you made with the

[ =2 [A]] buttons. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All]. However, if you
changed to another source image, you cannot return through
corrections you made using the source image before the change.
A recipe attached to a depth composite image is not applied in the
[Edited Image] in this function.

Also, depth composite image recipes are not attached to image
files saved with this function.
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Transferring a RAW Image to Photoshop

Save the image. A RAW image can be converted to a TIFF image (16bit) and transferred
to Adobe Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
[ Save fis. ] Photoshop starts up and the transferred image is displayed.

Cloze

? A single image can be transferred at a time

Click the [Save As] button to select and save required settings.

., Only one image can be transferred at a time. To send multiple images at
To exit, click the [Close] button.

a time, see p.131.

@ You can display this function as a function button in the main
window’s toolbar (p.120).

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.162) is added. The ICC profile
contains information about [Preferences] (p.155) or work color
space (p.90) set for each image as described and the appropriate
color information is relayed to Photoshop.
When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.
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Customizing the Main Window Toolbar

You can display buttons for frequently-used functions in the main
window’s toolbar.
You can also change how the buttons are laid out.

Select the [Tools] menu » [Customize toolbar].

The [Configure Toolbar] window appears.

Select functions to display in the toolbar.

Configure Toolbar H

Select items to show in the toolbar.

Print Move Up

Maowve Dowvn

HOR. Tool
Dual Pixel RAW Optimizer
Photoshop

Close

To rearrange buttons, select the function you want to change,
and then click the [Move Up] or [Move Down] button.

After specifying settings, click the [Close] button and close the
window.

The settings are applied to the main window’s toolbar.
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5 Printing Images

PrintinganImage ...,
Printing with Shooting Information.........................
Printing a Thumbnail List (Contact Sheet

Printing) ..........
Plug-in printing
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. - Introduction/
Printing an Image Contents

You can print images with a printer. As an example, the procedure to —
print one image on one sheet of paper is described here.

Downloading
Images
Select the image to be printed. —
) ] Viewing
Select the [File] menu » [Print]. Images
—
Close window Ctrl+W Sorting
Images
Save Ctrl+5
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D Editing
Batch process.. Ctrl+B Images

Save still image from movie..  Ctrl+Shift+D

[ Print... Ctrl+P P:;Sng
Print with detailed setting... Ctrl+ Alt+P I es
Print contact sheets Alt+Shift+P
Plug-in printing ’ Processing

Large Numbers
Add to collection Ctrl+G of RAW |mages
Remove from collection Ctrl+5hift+G
Clear collection Remote
Select collection 3 Shootlng
Delete collection 3 T—
Playing Back
Bookmark . .
okt Movies and Saving
Remove bookmark Still Photos
Move to Recycle Bin Del
Exit Alt+F4 HDR PQ
- ; - - - Mode

The printer’s print settings dialog box appears.

Print. Specifying

Specify the optimum settings for printing photographs in the Preferences

printer’s print settings dialog box and click the [OK] button.

N —
Printing begins. @ @
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

(3 C:\Users\xood\Desktop\occe: 03\IMG_0001.CR2 x|
Printer | Image | Text SetﬁngsJ
Printer:
fe e et v
Properties. ..
Media: 297.0mm x 210.0mm
A4 v
Media orientation:
() Portrait (@) Landscape
Media type:
Print Quality:
Borderless:
Print profile:
CMYK profile:
CMS settings...
Print Cancel Apply

Print preview

The image can be moved by dragging.
Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that appears.

=Q< To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can be applied to another
image when printing.

Memorized settings are options in [Printer], [Media], [Media orientation],
[Registration marks], [Header], [Footer], and [Image Information], and
settings in the [Settings] tab sheet.

@ You can set printer profiles (p.156).
If CMYK simulation is set, the image is printed in the set colors.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.

Select the [File] menu » [Print contact sheets].

Specify the required settings for printing, and then

click the [Print] button.

Switches the settings tab sheet

o

Contact sheet

Frinter | |mage | Text Settings]

Frinter:

IO »

Properties...

Media: 210.0mm x 297.0mm
Ad W

Media orientation:
(®) Portrait () Landscape
Media type:

Print Quality:

Borderless:

Print profile:

CMYK profile:

CMS settings...

' Print ' Cancel Apply

Print preview

Ny

2> To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can also be applied to another
image when printing.

Memorized settings are [Printer], [Media], and [Media orientation], and
settings in the [Image] and [Settings] tab sheets.

@ You can set printer profiles (p.156).
If CMYK simulation has been set, the image is printed in the set
colors (p.155).
By using this function in the edit image window, all images in the
window (not only the selected ones) are printed in a thumbnail
list.
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Plug-in printing
Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.
Specify the required settings for printing
photographs and then print.
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6 Processing Large Numbers of RAW Images

Batch Apply White Balance to Images (Personal White

Balance) .......coooiiiii 127
Registering Personal White Balance......................... 127
Applying Personal White Balance ...............ccc......... 128

Batch Save as JPEG or TIFF Images (Batch

Processing)....cccoevveerieiiiiiieeice e 129

Batch Transfer Images to Image Editing Software ......... 131

Batch Change the File Name of Images................ 132
Changing the File Name of Images in the Order in the

MaIN WINAOW ... oo 132
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Personal white balance data for versions before DPP 4 cannot be
applied.

Registering Personal White Balance

Adjust the white balance (p.52, p.53).
To adjust white balance, select a setting other than [ ()] from
the [White balance adjustment] list box (p.51). Registering the
adjustments is not possible if [|f4( )] is selected.

In the Basic adjustment tool palette, click the
[Register] button.

The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personal white balance H

Register current setting in personal white balance

Save..

? To use the registered personal white balance on another
computer

In step 3, click the [Save] button to write as a file.

Copy the file to another computer.

In DPP on another computer, display the window of step 3.

Click the [Load] button and in the window that appears, select the
copied file.

@You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Applying Personal White Balance

In the main window, select the image to which a
personal white balance is to be applied.

Select the [View] menu » [Tool palette].
The tool palette appears.

Click the personal white balance number button that
is to be applied.

Tool palette

Fine-tune

B —— oo

'ﬂ-

Auto Lighting Optimizer

(= Standard

Iy ‘Landscape) S

Gamma adjustment

B Linear

00 20 40

T b ol
Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Select the [File] menu » [Batch process].
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

IMG_D006GR2

Create storage subfolders for each file type
IMG_00075R2 o e

IMG_0008 GR2 Exif-JPEG Subfolder name  JPEG
IMG_0009GR2

IMG_0010GR2 Output setting

IMG_0011GR2

W& 0012GR2 Save as type Exif-JPEG (#.JFG) - Image quality 10
IMG_0013GR2

MG 0014GR2 Output resalution 360| dpi

IMG_0015GR2

MG _0017CR2 | Resr i

IMG_0018GR2 Width Height

IMG_D019.5R2 5472 x 3645 (5472 pixel x 3648 pixel] Unit | pizel
IMG_0020GR2

MG 0021GR2 Embed ISC profile

IMG_0022GR2

MG 002802 Shooting info setting  Include all shooting info

IMG_0024 GR2

IMG_0025GR2

IMG_0026CR2 File name

IMG_0027GR2 (®) Gurrent file name

MG 0028 GR2 () Mew file name

IMG_0029GR2 -

MG_0030GR2 String Additional string

IMG_0031GR2 0oooaoot

IMG_0032GR2 7

IMG_00335R2
Ex.: IMG_0001.JPG, IMG 0002.0PG

Image transfer settings

[ Open imags using saftware

Convert RAW images only Cancel

Batch settings H
IMG_0001CR2 Destination folder
IMG_00025R2 (®) Same as original files
IMG_0002CR2 =
- (L) Use this fold
IMG_0004GR2 - e s ol
IMG_0005GR2 C¥lzers¥user¥Pictures

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

In the processing dialog box, click the [Exit] button.

If you have selected [New file name] in [File name], [Sequence
number] has to be set.

By saving as explained above, a trimmed image (p.70) or dust-
erased image (p.85 to p.89) actually becomes a trimmed image
or dust-erased image.

You can also use this function in the editimage window. However,
all images in the window (not only the selected ones) are
converted and saved.

Introduction/
Contents

Downloading
Images

Viewing
Images

Sorting
Images

Editing
Images

Printing
Images

Procgssing
Large bers
of RA ages

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

HDR PQ
Mode

Specifying
Preferences

Q0O

129



? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.93) to edited RAW images.

A/

5@3 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, converting and saving images as JPEG
or TIFF images is recommended.

-:@/3 Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the preview window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
“Transferring a RAW Image to Photoshop” (p.119), you transfer images
that have first been converted and saved as a separate image, so the
transferred image will not be deleted after exiting the destination
software. The software used here as an example is Adobe Photoshop.

In the main window, select multiple images to be

transferred.

Select the [File] menu » [Batch process].
The [Batch settings] window appears.

Perform settings required for transferring (e.g. file

format).

Checkmark [Open image using software].

IMG_0001GR2
IMG_000205R2
IMG_00035R2
IMG_0004 GR2
IMG_00055R2
IMG_0006 GR2
IMG_0007CR2
IMG_0008CR2
IMG_0009GR2
IMG_00105R2
IMG_0011GR2
IMG_00125R2
IMG_00135R2
IMG_0014 GR2
IMG_0015GR2
IMG_0017 GR2
IMG_0018CR2
IMG_00195R2
IMG_0020 GR2
IMG_0021GR2
IMG_0022GR2
IMG_0023CR2
IMG_0024 GR2
IMG_0025GR2
IMG_00265R2
IMG_0027 GR2
IMG_0028CR2
IMG_00295R2
IMG_0080GR2
IMG_0031GR2
IMG_0032GR2
IMG_0033CR2

Batch settings

Destination folder
®) Same as original files
() Use this folder
C¥lUsers¥userfPictures

[ Greate storage subfolders for sach file typs

Exif-JPEG Subfolder name  JPEG
Qutput setting
Save as type Exif-JPEG (x JPG)
Output resolution 360 | dpi
[] Resize v
Width Height

472 x 3648 (6472 pixel x 3648 pixel)
Embed IGC profile

Shooting infa setting  Include all shooting info

File name
(®) Current file name
) New file name
String Additional string
nonoonat

v
Ex.: IMG_0001.JPG, IMG_0002.PG
Image transfer settines

[] Open image using software

Convert RAW images only

Image quality 10

Unit | pixel

Execute Cancel

The [Open] dialog box appears.

Select Photoshop.
In the [Open] dialog box, select a Photoshop file or a shortcut
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop.

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop starts up
and transferred images are displayed in transferred order.

To reset the transfer destination to another software, click the
[Browse] button in [Image transfer settings], and in the [Open]
dialog that appears, select the software and click the [Open]
button.

You can also use this function in the edit image window. However,
all images in the window (not only the selected ones) are
transferred.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Changing the File Name of Images in the

Downloading

Order in the Main Window Images

Select the [TO_OIS] menu ) [Start Rename tool]. When you change the order of the images in the main window, you can
The rename window appears. change in one operation the names of the files for the images, in the Viewing
Specify the required settings and click the [Execute] order they were rearranged. Images

button.

Change the order of the images in the main window Sorting
a C\Users\ood\ Desktop\aooae_03\ -0 I
e Extension (p-36). mages
DPP v || Shooting Date/Time v | Sequence number V| | Do not change v
em—— In the main window, select multiple images of which y
®) Fit to main window ; 0001 [ |Save sequence number H Edltlng
. the file names are to be changed. Images
- Shooting Date/Time
Shooting Date/Time
Day Month Year v
e e e o A 55 mges e . Select the [Tools] menu » [Start Rename tool].
[ \Cupyand\Renslr:\e (@ Insert underbar Printing
sersood Pioures . ] ] Images
Original File Name Modified File Name SeIeCt [Flt to maln WIndow]-
IMG_0001.CR2 ~ DPP_08-08-12_0001.CR2
IMG_0001.JPG DPP_08-08-12_0001.1PG 'I! C:\U sers\m\Desk P roc Si ng
IMG_0002.CR2 DPP_23-06-12_0002.CR2
IMG_0003.CR2 DPP_09-08-12_0003.CR2 Fl‘e name Large bers
e co0s = e 0n.2 s oPP v Shooting Date/Tme of RAWIfages
IMG_0006.CR2 DPP_12-08-12_0006.CR2
IMG_0007.CR2 DPP_12-08-12_0007.CR2 Basic Semngs
IMG_0008.CR2 v DPP_12-08-12_0008.CR2 . R t
or emote
(EE=T) = Cancel,.,... Shooti ng
(_)File name
Processing begins and the file names are changed. (O shooting Date/Time

? Changes cannot be made when the file name is duplicated

If a file name in red text appears in [Modified File Name], the file name is )
duplicated. Changes cannot be made if even one file name is Click Fhe [Execute] button. _ o _ HI\DIIRdPQ
duplicated. Change the settings so that duplication does not occur. The file names are changed and the order in the main window is v
maintained.
Specifying
Preferences

@ You can change the file name of only one image in the main
window by selecting the thumbnail, right-clicking with the mouse,
and selecting [Rename] from the menu that appears.

You cannot start up the rename tool from the [Collection] window
(p-102). You also cannot change the file name of one image.

Specify the required settings.
To copy an image, checkmark [Copy and Rename].
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Remote Shooting

Remote Shooting..........cooooveiiiiiiii,
Registering Click White Balance in the Camera
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Remote Shooting

You can perform remote shooting by using “EOS Utility” which enables
communication with a camera in combination.

For remote shooting, “EOS Utility Ver. 3.x” must be installed on your
computer. For information on cameras compatible with “EOS Utility Ver.
3.x”, refer to “EOS Utility Ver. 3.x Instruction Manual” (electronic manual
in PDF format). This function is not available on EOS M series cameras
other than the EOS M50, or PowerShot cameras.

Click the [Remote Shooting] button on the toolbar in
the main window.

@ Digital Photo Professional 4 - [Folder: C:\Users\xood Desktop\xoocx

File Edit View Thumbnpails Preview Label Adjustment Tools Window

Edit Irmage 1 i Check Remote Shooting

Folder Eank mark Filter ON OFF o

= Desktop
00K
This PC

Remote shooting setting window appears.

Set the [Destination] in the Specify Remote Shooting
Folder window.

Specify Remote Shooting Folder “

Deztination

() Gurrent Folder
G Usersiaoncod oo oo
(®) Use this folder
G Ugersibaoondfaonc: Select..

Destination falder

Mew folder 1

File Mas
Do not modify ] Settings..

Cancel

To save to the currently selected folder, select [Current Folder].
To create a new folder for saving images, select [Use this folder],
click the [Select] button, then select the destination and enter a
name for [Destination folder].

After specifying settings, click the [OK] button.

The remote shooting window appears.
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@ You can change the [File Name] for Specify Remote Shooting _
Folder window. DO\INnIoadmg
(If [Do not modify] is selected, images are saved with the file names mages
set on the camera.) O —
Click the [Settings] button to display the Set file name for captured Y;?;Vigsg
image window. 9
Set file name for captured image E
Sorting
Do not modify v Images
File Prefix Customize...
MG Editing
Aszign Sequence No. |mages
Mumber of Digits 4
Start 1
Shooting Date Format | Day Month Year v Delimiter | Underline v Printing
DDMMYYY v You can perform shooting while checking the image by switching iiciges
the window to multi-layout.
Processing
Large Numbers
Connect a camera and a computer, and turn on the of RAW Images
[ oK ] Cancel cameras power.

Click the [Live View] button.

Select a naming rule for image file names from the list box.
You can click the [Customize] button and customize naming rules

for file names. _ o MoSiI:?:n?st?:\rin
You can individually set prefix characters, number of digits for Still Photos
serial numbers, and the start number for file names. BN FADTROM0
If you are using the shooting date in file names, you can specify Jestination : HDR PQ
the date format (order and style for year-month-date) and Mode
dividing characters on the Set file name for captured image subfolder
window:
iy : : Specifying
After specifying settings, click the [OK] button. Preferences
The Set file name for captured image window closes.
Atfter clicking the [Remote Shooting] button, you can click the
[m] button at the bottom right of the main window to show/ @ @
hide the [Camera Control] palette.
Live View window of “EOS Utility” appears. @
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Specify the required settings.

(= Remote Live View window = =

WhiteBalance

Lv_ClickivB

Apply to shot images

263 1 K 66 R ESEE T

For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual).

Click the [Settings] button.

GCamera

ECQIS MR

1560 F40 IS0400

folder
s 07 <
ere

e

The capture window of “EOS Utility” appears.

Specify the required settings.
[ EOS XXX = =

[alad

ME

O -

™~  F0
@B O G 400
& e

oM 5 | TY | [ O |

Pic Standard

Live View shoot. .
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The shot image is displayed.

The shot image will be saved in the folder created in step 2.

The images in the folder mentioned above will be displayed in

the thumbnail display area.

You can also create a sub-folder in the folder mentioned above to

save images. To create a sub-folder, click the [Create subfolder]

button on the remote shooting window, enter [Folder name] on

the screen appeared, then click the [OK] button.

Press the [l ] button to display DPP and EOS Utility windows

uniformly in line.

» Supported with EOS Utility version 3.8 and later.

+ If you are using multiple monitors, DPP’s main window and
EOS Utility’s remote window can only be lined up uniformly
when on the same monitor.

@ Do not exit “EOS Utility” when remote shooting is being set or

5

performed.

In the cases below, perform shooting with EOS Utility.

* You want to autofocus with EOS Utility’s shoot button

* You want to perform continuous shooting

You can perform shooting while comparing the shot image with a
pinned image by pinning an image (p.21). This is convenient for
image selection.

Registering Click White Balance in the Camera

During remote shooting, you can register click white balance to the
connected camera. To use this function, EOS Utility version 3.4.20 or
later must be installed on your computer.

This function is not available on EOS M series cameras other than the
EOS M50, or PowerShot cameras.

Display the shot image to be used as the standard
for white balance.

This function supports only RAW images with a “*.CR2” or “.CR3”
extension.

Select the destination where to register click white
balance.

L=l
EQi5 KK

1750 F40 IS0400

subfolder

Reeistered to :

A0

Select the destination where to register white balance from the
[Registered to] list box. Options in the list box depend on the
camera model.
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Select a point that is to be the standard for white
balance in the shot image, and register the white
balance in the camera.

era

EQi5 KK

1750 F40 150400

iIder

s 07 o
leeistered to
MR -

Pad * |

Click the [[EZT=M] button, and in the displayed image in step 1,
click on a point that is to be the standard for white balance with
the mouse.

The white balance is registered to the destination selected in
step 2, and applied to displayed images.

Click [[IEZI=H] again to exit the function.
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8 Playing Back Movies and Saving Still Photos

Playing Back Movies and Saving Still Photos

140
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Playing Back Movies and Saving Still Photos

In systems running 64-bit versions of Windows 8.1 or later, you can use DPP to play back MOV or MP4 movies shot using a supported camera and
save still photos from the movies as JPEG or TIFF images. To use this function, [Play with Digital Photo Professional 4] must be selected in [Movie file
playback] in the [General Settings] tab sheet in [Preferences].

Note that you cannot edit movies in DPP.

Double-click the movie thumbnail in the main window (thumbnail layout).

2E a0

JRGE (

The preview window appears.
If the preview control panel does not appear, select the [Preview] menu P [Preview control panel].

Introduction/
Contents

S ——

Downloading
Images

S

Viewing
Images

Sorting
Images

Editing
Images

N

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooﬂng

Pla ack
Movie aving
Stil tos

HDR PQ
Mode

Specifying
Preferences

Q0
©

140



Use the preview control panel for each operation.

(1)

(2)

()

(4)
()

(6)

(10) Save as still photo

(4) Show playback time

(5) Frame position slider

(6) Frame no./Total frames

(2) Next frame

(1) Play/pause

(3) Previous frame

Play/pause
Play and pause the selected movie.

Next frame
Move forward one frame. When movie playback is paused,

this allows you to advance the movie one frame at a time.

Previous frame
Move back one frame. When movie playback is paused,
this allows you to rewind the movie one frame at a time.

Show playback time
Shows the playback time.

Frame position slider
By dragging the slider left or right, you can move the
playback position while a movie is playing or paused.

Frame no./Total frames
Shows the current frame number in the movie being
played back or shown and the total number of frames.

(7

(8)

9

(7) Mute/unmute
(8) Volume slider
(9) Viewing LUT on/off

Mute/unmute
Turns audio output on or off.

Volume slider
Drag the slider left or right to adjust the volume for the
movie being played back.

Viewing LUT on/off

Enables or disables Viewing LUT for movies shot with
Canon LOG specified.

This setting can also be changed during movie playback.

(10) Save as still photo

Allows you to capture a still photo of the movie frame
currently being displayed.

When you click the button, the [Convert and save] window
(p.94) appears. Specify the necessary settings, and then
click the [Save] button to save the image.

Note that you cannot save a still photo while the movie is
playing back. Pause the movie and then save the still
photo.

If the preview control panel does not appear, select the [Preview] menu P [Preview control panel].
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5

On some supported cameras, shooting a movie generates a “. THM”
file that is saved together with the movie file.The “. THM” file has the
same image number as the movie file and records the shooting
information. In DPP, the movie file and “. THM” file must be stored in
the same folder when the movie is played back.

You can also play back movies in the following windows:

* Main window (multi-layout)

+ Edit image window

» Remote shooting window (multi-layout)

» Multi-function preview window

In Preferences, you can change the movie playback application
to that used by your computer’s OS or to EOS MOVIE Utility.
(p.152)

For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.
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HDR PQ Mode

HDR stands for High Dynamic Range and refers to technology that
enables expression of “a wider range of brightness” than with the
conventional range. The conventional range of brightness is referred to
as SDR (Standard Dynamic Range) = “standard brightness range” when
compared to HDR.

The “PQ” in this function’s name, HDR PQ, stands for Perceptual
Quantization and refers to the gamma curve of the input signal for
displaying HDR images. It is capable of brightness up to 10,000 cd/m?
and approximates human visual characteristics. HDR PQ mode displays
RAW images shot with a supported camera in HDR PQ (10-bit) on an
HDR display compliant with the HDR standard. (Actually displayed
images depend on monitor performance.)

You can also edit and save images.

In addition, DPP has the function “Creating HDR (High Dynamic Range)
Images” (p.108). However, this function assumes that display is in
conventional SDR, and combines exposure-bracketed images (HDR
compositing) to achieve image expression that uses a wide range of
gradation from shadows to highlights, and is thus different from HDR PQ
mode.

® On 32-bit OSs, this function is not available.

System Requirements for HDR PQ Mode

System Requirements

OS (operating

Windows 10 (Version 1607 or later), Windows 8.1,
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Contents

Downloading

performance.

* Images may not be displayed correctly depending on display

Images
system) Windows 7 (all 64-bit versions)*
CPU Core i series 3.4 GHz or higher y
Viewing
RAM 4.0 GB or more of RAM (8.0 GB or more Images
(memory) recommended)
RAW, CRAW, and DPRAW images shot with the EOS Sorti
R Irr?a Igg
Supported | £ AW and DPRAW images shot with the EOS 5D g
images
Mark IV
HEIF images saved in DPP Editing
* Since HDR PQ cannot be displayed in Windows 8.1/7, images are Images
displayed in SDR according to the characteristics of the display so that
they approximate display in HDR PQ as much as possible.
Printing
Images
Systems where images are displayed o :
. rocessing
accurately in HDR PQ Large Numbers
of RAW Images
gysségr;;c)eratmg Windows 10 (64-bit version) Version 1709 or later -
GPU (vid Video cards: NVIDIA GeForce GTX 10 series, Shooting
(video AMD Polaris architecture, etc.
card) 4GB id ded
( or more video memory recommended) Playing Back
Display Products that meet HDR10 standards* Movies and Savin
Still Photos
Cable HDMI 2.0a/b
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H M 1 Introduction/
Displaying Images in HDR PQ Mode et
This section explains how to display images where system requirements Select an image in the main window, etc., and then T —
are as de”scrlbed in “Systems where images are dl_splayed accurately in open the Settings tool palette and select [On] in Downloading
HDR PQ” on the previous page. Additionally, in Windows, you must [HDR PQ] Images
specify the HDR option for display settings. )

Check that checkbox in [Preferences] » [View Y:a‘:‘ggsg
settings] tab sheet » [HDR display] is checked. \

e * Sorting
Thumbrnail order @ Off Q On Images
R e : gg::i::;:g Wiork color space
Toeltee Editing
o 1031 s Images
R B -

aettings..
Imaee backeround color Printing
Previem sareen ackeraund colr Images
Image zooming mulation profile
®) Singleclick O Double-click Processing
[ Ruzl: D}-{‘EDyR*d\sp\ay for HDR images (in environments that support HDR display) ] Size when opening RAW images Large Numbers
of RAW Images
: : The image is displayed in HDR PQ mode. Remote
*Changes take effect after restartin Cancel . . . . . ShOOtlng
- Images are displayed in HDR PQ only in the main window, the
If not checked, checkmark the checkbox, click the [OK] button, edit image window, the preview window, second windows, and Plaving Back |
and then restart DPP. the enlargement check screen. In other windows, images are Moviegaﬁd Saving
displayed in SDR according to the characteristics of the display Still Photos
so that they approximate display in HDR PQ as much as

possible.
The following icons are displayed in the preview window and
thumbnail frames for images displayed in HDR PQ mode.

* Thumbnail frame: I_-‘Sp;acifying
references

* Preview window (when connected to an HDR display):
» Preview window (when connected to an SDR display, when
the computer’s OS is Windows 8.1/7):




HDR PQ mode display when an SDR display is connected
You can use images in HDR PQ mode also when connected to an
SDR display.

When an SDR display is connected, the image is displayed
according to the characteristics of the SDR display so that the
image approximates display in HDR PQ on an HDR display as
much as possible.

However, the large difference in regions that can be rendered
between HDR displays and SDR displays results in a different
impression of colors and gradations.

HDR PQ mode display on a computer with a Windows 8.1/7
oS

If the computer’s OS is Windows 8.1/7, images are displayed in
SDR according to the characteristics of the display so that they
approximate display in HDR PQ on an HDR display as much as
possible. However, the large difference in regions that can be
rendered between HDR PQ and SDR results in a different
impression of colors and gradations.

Recommended display environments for mixed HDR PQ
mode images and SDR images

It is recommended that you have a multiple-monitor environment
using two displays, an SDR display and an HDR display, when
using both HDR PQ and SDR display for images. On the SDR
display, you can display the DPP thumbnail display, tool palettes,
and SDR images, and you can use the HDR display to display the
HDR images.
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Function Restrictions when Using HDR PQ Mode

Item

Restriction

Quick check window (p.31)

Displayed in SDR according to the characteristics
of the display so that images approximate display
in HDR PQ as much as possible

Displaying AF points (p.22)

Display function Not displayable*
Displaying grid lines (p.22)
Highlight/shadow warning (p.23) Not displayable
Displaying properties in preview image (p.24) Not displayable*
Auto Lighting Optimizer (p.58)
Unavailable

Basic Adjustment tool palette

Adjusting the brightness of shadows/highlights (p.54)

Changing the Picture Style (p.49)

Only standard usable

Using Picture Style Files (p.51)

Unavailable
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Sharpness Only unsharp mask available
Linear (p.57)
Unavailable
Automatic adjustment of gradation and luminance (p.57)
Detailed Adjustment tool palette | Reducing color moiré in images (p.69) Unavailable
Partial Adjustment tool palette Reducing color moiré (p.83) Unavailable

Settings tool palette

Setting the work color space (p.90)

Not selectable

Setting the size of RAW images when opening (p.92) Unavailable
Compositing images (p.104)

Tools Unavailable
Generating HDR (High Dynamic Range) images (p.108)
Using the soft-proof colors function (p.91)

Simulation function Unavailable®

Color matching settings (color setting of the monitor)
(p.156)

* The function is available when using an SDR monitor.

Since recipes that become attached to images when HDR PQ is set to On and when HDR PQ is set to Off are not compatible, neither can be applied

to the other.
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Switching between HDR and SDR modes clears the following recipes:
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. . Auto Lighting Optimizer / contrast / shadow / highlight / color tone / color saturation / filter effect / toning Images
Basic Adjustment tool palette : . )
effect / sharpness / linear / Picture Style / gamma adjustment
Tone Adjustment tool palette Tone curve adjustment (RGB), brightness, contrast \Iliewing
mages
Settings tool palette Work color space, size when opening RAW images
Color Adjustment tool palette Hue and saturation adjustments for the entire image, color adjustments for specific gamuts Sorting
Images
Detailed Adjustment tool palette Reducing color moiré
Partial Adjustment tool palette Partial adjustments and reducing color moiré Editing
Images
Dust Delete / Copy Stamp tool Stamp
palette Dust delete data -
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Saving Images Displayed in HDR PQ Mode in JPEG/TIFF Format

You can save the editing results of images displayed in HDR PQ mode
in the same way as SDR images.

See “Saving Editing Results” (p.93) for information on how to save
images.

When saving an image displayed in HDR PQ mode as a separate
image (JPEG or TIFF image), it is saved as an SDR image. The
image is processed so that it approximates display in HDR PQ on an
HDR display as much as possible. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.

For information on saving images in HEIF format, see “Saving Images
Displayed in HDR PQ Mode in HEIF Format” (p.150).

®When an image displayed in HDR PQ mode is saved as a separate
image (JPEG or TIFF image), the work color spaces of the saved
images are all fixed at sSRGB.
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Saving Images Displayed in HDR PQ Mode in HEIF Format

Images displayed in HDR PQ mode can be saved in HEIF format
(extension .heic) only if Canon HEVC Codec is installed. HEIF stands
for High Efficiency Image File Format. If you save in HEIF format, you
can save images and maintain the wide dynamic range of HDR PQ.

Canon HEVC Codec can be downloaded from the Canon website.
See “Saving Editing Results” » “Saving as a separate image” (p.93)
for information on saving images. When selecting the image type in
step 3, select [HEIF (*.HEIC)] from [Save as type] and then save the
image.

You cannot select the image quality or compression rate when saving
in HEIF format.

You can [Save], [Save As], [Convert and save], or [Batch process]
HEIF images.

You can save a HEIF image as a JPEG or TIFF image. (It is saved as
an SDR image.)

The image is processed so that it approximates display in HDR PQ on
an HDR display as much as possible. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.

See “Saving Editing Results” (p.93) for information on how to save an
image as a JPEG or TIFF image.

® When a HEIF image is saved as a JPEG or TIFF image, the work
color spaces of the saved images are all fixed at sSRGB.
HEIF files generated with software other than DPP are not
compatible with HEIF files saved in DPP (both, extension .heic).
Only HEIF files saved in DPP can be loaded into DPP.
Images saved in HEIF format cannot be printed using Print Studio
Pro software for Canon inkjet printers.
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10 Specifying Preferences
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Specifying Preferences
You can change the various functions of DPP in the [Preferences] -
window. Check the contents of each window and set. General Settmgs

Refer to the detailed explanations if available, as well as to each You can specify the folder that opens when DPP is started up, saving of
window. recipes, etc.

Select the [Tools] menu » [Preferences]. Prererences KX

Giene settings Startup folder #

The [Prefe renceS] WindOW appears' Image Fressmg 1 ®) Last displayed folder
Image Processine 2 ) Specified folder

Color manage ment C¥Users¥user¥Pictures Browse..

Select a tab sheet, specify the settings, and then

Froperties display :
. settings (®) Display message when adding file
CIle the [OK] button. O Add to file automatically

Movie file playback

Save recipe

(®) Play with Digital Phato Professional 4
Preferences “

() Play with default application

SR e G Movies that cannot be plaved with Ganan applications are passed to the default application.
Tmags Prosessing | ® Last displayed folder
Insge Pracessing 2 Per— Receivine fies fram EOS Utility

7| Automatically focus on a file received
Calor management Ci¥lisers¥user¥Pictures Browss.. v

View settings Default value of output resalution *

Bave recipe 350 dpi(1-60000)

Properties display R
sattings @ Display message when addineg file

) fidd 1o file automatically Temparary Files*

Mavie file playback* Gurrently used 15 MB Delete Reset
& Pl Defal Prate Mozl Amount of Dual Pixel RAW cache used 00 MB Delete
- Maxi lsble on disk 4GB 0 32
) Play with default application faximum svailable on dis
Mavies that cannot be played with Canon applications are paseed to the default application. Destination C#Users¥user¥ AppDats¥Roaming¥Canon Tne IC Erowse

Receiving files fram EOS Utility

] Automatically focus on a file received
< *Changes take effect after restarting _OK Gancel

Default value of output resalution %

350 dpit 1-60000)

Temporary Files*

et o i no - Movie file playback

i sl on ik ‘e o » Choose the application used for playing back movie files. Movies that

pestnaten s e cannot be played back in DPP or EOS MOVIE Utility are played back
e e et st et = with the movie playback application specified with the computer’s OS

settings. For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.

® If you have changed the movie playback application to EOS
MOVIE Utility, and playback does not start after starting up EOS
MOVIE Utility, check compatible models with the EOS MOVIE
Utility Instruction Manual.
If the movie playback application specified with the computer’s
OS settings is set to EOS MOVIE Utility, MOV and MP4 files shot
with the models that are not compatible with EOS MOVIE Utility
will not be played back. Check the OS settings and change the
movie playback application.
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Default value of output resolution .
When saving JPEG or TIFF images created by converting RAW images Image processing Downloading
(p.93, p.129), the resolution of the JPEG or TIFF images can be set. You can specify settings for processing images in DPP. Images
Temporarily saved files Image Processing 1 Viewing
You can delete temporarily saved files that were created and improve o— x| Images
operation speed, change file save destinations, or set a limit on disk 8 e sty 4
usage. Any changes you made will be applied when you start up DPP 8 e e e e s
again. T Sorting
) ; ¢ Images
[Delete] button: Click the [Delete] button to delete vt mepilice
temporarily saved files. o e o e o s
[Maximum available on disk]: Set with the slider (setting range: 0 to Ndm Editing
32 GB). - e Applics o RAW imaces orly Images
Once usage reaches the limit, files ' 0
are erased starting with the oldest. 2 Printing
[Destination]: Click the [Browse] button to change A, senten 1o i ety Images
the save destination in the dialog that —
appears. B Processing
[Reset] button: Click the [Reset] button to revert all — Large Numbers
changes to the original settings. i of RAW Images
*ohangss taks effect after restorting Gance
Remote
Shooting

JPEG image quality
[Remove block noise and mosquito noise] Playing Back
You can improve the quality of a JPEG image by reducing the noise  Movies and Saving
. . Still Photos
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.93, p.129) and for JPEG images that to HDR PQ
be saved with a different name. The higher the JPEG image’s v
compression rate, the better the effect. And when the compression
rate is low, the effect of noise reduction may not be noticeable.

Modified Picture Style settings
If you checkmark the checkbox, setting values for [Color tone], [Color

saturation], [Contrast], [Unsharp mask], [Sharpness], and other options
will be retained for each Picture Style.

® On 32-bit OSs, only deleting temporarily saved files is
possible.
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Noise reduction defaults
You can set a default beforehand for the noise reduction level. Only
RAW images are supported.
When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.

For images not having a recipe attached, the default noise reduction
level set here is applied. If you changed settings, they will be applied to
images as the default noise reduction level when you start up DPP
again.

For images with a recipe attached, the noise level recorded in the recipe
remains as it is and the default for noise reduction level set here is not
applied.

Sharpness defaults
You can set a default beforehand for the sharpness. Only RAW images
are supported.
When [Apply camera settings] is selected, you can pre-set a

sharpness that suits the camera settings beforehand as the default.

When [Set as defaults] is selected, you can pre-set preferred
default settings for the sharpness and unsharp mask beforehand.

For images not having a recipe attached, the defaults for sharpness and
unsharp mask set here are applied. If you changed settings, they will be
applied to images as the default sharpness level when you start up DPP
again.

For images with a recipe attached, the sharpness level recorded in the
recipe remains as it is and the defaults for sharpness and unsharp mask
set here are not applied.

@ On 32-bit OSs, the [Preview image settings] menu is not
displayed.

Image Processing 2

neral settings Quick check windom settings%
(®) Show original imaee

© Show image with recipe applied

Graphics pr
[] Use eray

Use ara

for imsgs processing

to speed up preview display

Default size when opening RAW imagest
Criginal size {do not chanee) v

# Applies to display of compast GR3 files and ta resizing when images ars converted

#Chanees take effect after restarting

Preferences “

Quick check window settings
You can specify image display settings for the quick check window.
By selecting [Show image with recipe applied], images with a recipe
attached are displayed with the recipe applied. Any changes you made
will be applied when you start up DPP again.

Graphic processor settings
If you checkmark [Use graphics processor for image processing], the
graphics processor is used to allow a faster preview display. The CPU
handles convert and save tasks as well as print tasks as usual. Settings
will be applied the next time DPP is started up.
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To use this function, a NVIDIA CUDA (Compute Capability 2.0 or
higher) GPU* with at least 1.0 GB of video memory is necessary.
Additionally, the latest NVIDIA GPU driver must be installed.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

* GPU is an abbreviation of “Graphics Processing Unit”.

The [Use graphics processor for image processing] checkbox is
available only when a supporting GPU is installed.

If the OS or other application software is using the GPU,
processing by the GPU may not be possible in some
circumstances. In such a case, the CPU handles processing as
usual.

Default size when opening RAW images
This applies only to RAW images with the extension “.CR3” that were
shot with [c@Am ] selected on the camera.
This specifies the size defaults when RAW images are opened in DPP.
This default size is also set when RAW images are converted and saved
as JPEG or TIFF images.
The settings are applied the next time DPP is started up.

Preferences “

Default settings of Work color spacs *
® sRaB © Apple RGE

O Adobe RGE © GolarMatch RGE
() Wide Gamut RGE

[[] Use shooting color space as werk color space:

Color matching settines
For display

) sRGE
(®) Use the OS settings

() Manitor profile

Printing profile
[ MNone — -]

GMYK simulation profile
[ Hore —- -]

*Changss take effact after restarting @z

Default settings of Work color space
You can select the color space (p.163) to be applied as a default setting
of RAW images from five types. The color space set will be applied as
the color space when a RAW image is converted and saved
(p.93, p.129) or printed (p.122 to p.125).
If you change the color space, and you restart DPP, the set color
space is applied as the default color space.
You can check the color space that is set in an image in all windows
except the quick check window.
If you checkmark [Use shooting color space as work color space],
the color space specified with the camera when the image was shot
will be set as work color space.
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Contents
=)= Changes are not applied to the edited image View Settings _
Downloading
Even if the default setting is changed, the new default setting is not You can set layout for screen display. Images
applied to edited (i.e., adjusted using the tool palette, cropped, dust-
erased) images. Change the settings individually. — Viewing
@ You can set a color space that is different from the default settings B T . S iages
for each image (p.90). 5o ot o £ i Do
e Sorting
Color matching settings (color setting of the monitor) H, -
Where a profile (p.162) is attached to the monitor you are using, you can — e st
display an image in more faithful colors by setting the profile. Editing
If you select [Use the OS settings], the color profile set in Windows e ok Images
will also be applied in DPP. If you are using multiple monitors, the N
profile set for each monitor is applied to DPP. HD:d'I” SRt Printing
Select the [Monitor profile], click the [Browse] button. You can 1 U HOR dlo o HOR g vttt st HOR i) Images
select a profile for your monitor in the dialog box that appears.
< > Processing
I . ) . . . Large Numbers
=)= Precise coloring with a third-party monitor color reader “Changes ke et afer et of RAW Images
_If you use a profi_le create(_j using a third-parFy monitor color reader, Thumbnail order -
Images can be displayed in even more precise colors. Specify the default order of images in the main window, and that the Shooting
order of rearranged images be maintained. If you checkmark the
Printing profile (color setting of the printer) checkbox, the order of rearranged images is maintained starting the Playing Back
Where a profile is not attached to the printer you are using to print next time you select a folder (p.36). Movies and Savin
images, you can print an image, simulating the colors displayed on Still Photos
screen by setting the profile in DPP. Reset user interface
You can reset user interface settings. HI\DIIEdF;Q
@ When you set a profile for printing in DPP, set the color adjustment Choose from either of 2 reset states.

By checkmarking the [Restore defaults at startup] checkbox, settings
revert to their original settings for next time you start up DPP. The
checkmark is also removed from the checkbox for the next startup.

function of the printer driver to off. If it is left on, the image may not
be printed in colors close to those displayed on screen.
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Propertles D|5p|ay Settmgs You can specify detailed settings for [Display settings for thumbnails Downloading

You can specify settings for shooting and recipe information that with info], [Display settings for thumbnail list], and [Display settings for Images
appears with thumbnails and in the preview window. preview properties].
Items that can be selected appear in the list box at left, and actually
— x| displayed items appear in the list box at right. Specify items with the
— [Add >>] button and [<< Remove] button. You can also change the
T — display order with the [Move Up] button and [Move Down] button.

Show A/ Tw/I50 on thumbnails

Shery ez & G el Greleae edficd msire Sorti ng
Images

|

Viewing
Images

|

Preview properties font
e 16 pt Browse Restore Defaults

Properties ta display

Display ssttings for thumbrails with info v

Editing
Images

N

Add >

Printing
Images

<< Remove

Processing
Worelp ] [Merebom Large Numbers
of RAW Images

*Changes take effect after restarting Sarce)

Remote
Shooting

Thumbnail display settings
You can specify information that appears on thumbnails.

S —

If the [Show Av/Tv/ISO on thumbnails] checkbox is checked, Av/Tv/ISO Mocilgzi;?dB&‘?:\rin]
information is displayed on thumbnails if thumbnails are set at Size 3 or Still Photos
larger.
HDR PQ
Mode

Preview properties font
You can specify the font used for information displayed in the preview
window.

Q0

@ All the property items may not be displayed depending on the @.
combination of window, preview window, or the size of thumbnails. S
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. Introduction/
Troubleshooting Contents
If DPP is not operating correctly, refer to the subjects below. - - -

P J y : A recipe could not be pasted (applied) to another image B
ownloading
. Since recipes are not compatible between RAW images and JPEG or Images
Installation can not be completed correctly TIFF images, neither can be applied to the other.
Select an administrator-level privilege ([Computer administrator], : : - c Viewing
[Administrator], etc.) when setting the user. You cannot install the Colors are subdued in the LRSS when viewed with Images
software if the user setting other than an administrator-level privilege other software
is selec_te_d. For detailed information on sel?ctlng an administrator- If a RAW image which has a color space other than sRGB is Sorting
level privilege, refer to your computer User’s Manual. converted and saved as a JPEG or TIFF image (p.90, p.155), the Images
colors will be subdued when viewed in software that is only
DPP does not work compatible with sSRGB color space. In such a case, set the RAW y
DPP does not operate correctly on a computer if its system image’s color space to sRGB, convert and save again as a JPEG or E::ér;g
requirements are not met. Use DPP on a computer with compatible TIFF image, and then view the image.
system requirements (p.3). The Auto Lighting Optimizer (p.58) is a function compatible with
Even if your computer has the RAM capacity (memory) described in cameras equipped with the Auto Lighting Optimizer. Printing
the system requirements (p.3), if other applications are running at the Adjustments made with the Auto Lighting Optimizer cannot be applied Images
same time as DPP, you may not have sufficient RAM (memory). Exit to RAW images shot with the cameras not compatible with this
any applications other than DPP. function. Processing
Large Numbers
The card reader does not detect the SD card The colors of the image displayed on screen and of RAW Images
Depending on the card reader and computer OS used, SDXC cards the colors of the printed unage do not match Remote
may not be correctly detected. In such a case, connect your camera If the color of the monitor that displays an image is not adjusted Shooting

and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility.

Images are not displayed properly

Images that are not supported by DPP are not displayed. (Thumbnail correctly (p.156), the color of a printed photograph and the color of an

images are displayed as [?].) On a 32-bit version PC, when more image on screen can be more closely matched. Using a Canon printer HDR PQ
images than the maximum displayable amount are detected, images automatically sets up the profiles for the printer, so you only need to Mode
beyond the maximum are not displayed. (Thumbnail images are set the color of the monitor to bring the colors closer to each other.

displayed as [?].) There are various types of JPEG and TIFF images, e . - Specifying
so JPEG images other than Exif 2.2, 2.21 or 2.3 compatible images Printing a large number of images in batches Preferences

and TIFF images other than Exif compatible images may not to be
displayed properly (p.4).

correctly, or if the profile for a printer that is to print image is not set
up, the color of the image displayed on screen and the color of the
printed photograph may differ greatly. If the color of the monitor that
displays images is corrected and the profile for a printer is set up

cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

Playing Back

Movies and Savin
Still Photos

Q0O
©
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Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

Uninstall the software according to the OS software uninstalling
method.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.
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Image Frame Information in the Main Window and Edit Image Window (.13, p.100)

Check mark (p.33, p.34)

Image type

Rating mark

Trimming (cropping) range 2 (p.70)

Recipe mark

*3
(p.33, p.34) GPS mark

IMG_0003.CR2

File name

Pinned image setting mark (p.21) Multiple image display mark
(p.22)

150800

IMG_0030.CR2

Lens aberration Shooting

correction mark information "
Split movie mark

(p-74)

Unsaved editing content mark

Digital Lens Optimizer mark (p.78)

*1 Displayed on RAW+JPEG images displayed as a
single image (p.15).

[
[

DPR

] is displayed in RAW images.
] is displayed in Dual Pixel RAW images.

*2 \When aspect ratio information is attached to an image
shot with any supported camera other than the EOS 5D
Mark I, the image is displayed as a cropped image.

*3 Displayed on images shot on a GPS function-
compatible Canon camera.

*4 Shows that the movie is split and includes movies
other than that shown in the thumbnail.
The following icons may be displayed:

3 : No final movie
B3 : No initial or final movie
] - No initial movie
] : All split movies present

VGA30IPB.MOV

[ 1 is displayed in an image
frame when editing is not
possible.

Movies played back using
software other than DPP are
displayed with a [ [ ] icon in the
thumbnail image.

For information on icons displayed
in HDR PQ mode, see “Displaying

Images in HDR PQ Mode” (p.145).
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Glossary
RAW image

EOS camera RAW images are recorded in an uncompressed 14bit or
12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB :

Adobe RGB :

Apple RGB :

ColorMatch RGB :

Standard color space for Windows. Widely used for

the standard color space of monitors, digital
cameras, and scanners.

A wider color space than sRGB. Mainly used for
printing for business purposes.

Standard color space for Macintosh. A slightly
wider color space than sRGB.

A slightly wider color space than sRGB. Mainly
used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

Y

0.8

sRGB
—— Adobe RCE
-------- Apple RGB
————— ColorMatch RGB
———— Wide Gamut RGB

Color range that can be
seen by the human eye

08 X
Gamma White point
value (color temp.)
sRGB 2.2 6500K(D65)
———— Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
——————- ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.
Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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IndeXx
A
Adjust JPEG IMAQES.......uuuuuuuuiiiiiiiiiiiiiiiiiiiiiiieiiessressresssessssseseeseeeseeeee. 45
Adjust TIFF IMages. .....uuuuuiiiiiiiiiiiiiiiiieiiiiieeeiiee et eeeeeeeeeeeeee 45
Adjusting
Adjustment Contents (ReECIPE) .....ccuvvveiiieeeiiiiiieieee e 98
Apply Adjustments. ... 97
Automatic Adjustment (Gradation, Luminance)..........cccccccccuuunnes 57
BrIghtNeSSs .....oveiiiiiiieeee e 48, 61
Brightness of Highlights.............ooiii 54
Brightness of Shadows..............ciiiiiiiii 54
Click White BalanCe ........c..oeeeeeieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee 52,62
Color Saturation ...........cccccccuuuuueiiiiii 55
Color TEMPErature ........cooo i 53
(0701 (o] g o] o 1= T RO PP PP OUPPPRROPRIN 55
(070] 011 7= 11 SHTTT TR 54, 61
Copy AJUSTMENTS .....ouviiiiiiiiiiiiiiiiiiiiiieeiiieeeee e ee e e e eeeeee e 97
DynamiC RANGe........coooiiiiiiiiiiiie e 56, 65
Filter Effect ... ..o e 56
[ LU 66, 67
MONOCKHIOME ... 55, 67
Personal White Balance ............coooovvevviiiiiiiiiiiiiiiieiiieeee e, 127
Picture Style File ... 51
SatUratioN ... oo 66, 67
Save AdJUSIMENTS .......uvviiiiiiiiiiiiiiiiiieee e 97
SNAIMPNESS ...uutiiiiiiiiiiiiiiie ittt e e eeabaeeeeesseerreeaesesrereeeeeeeeeeeeeees 59
Tone Curve AdiustmeNnt.........ccoooiiiiiiiic s 63
ToniNg EffeCt ..o 55, 56
White BalanCe ..., 51
Adjusting Brightn@ss ........oooiiiiiiii e 48
Adjusting TONE CUIVE ......uuviiiiiiiiiiiiiiiiieeeeeeee st e e e e e e e e e e eeeeees 63
Adjustment Contents (RECIP) ......ccevviiiiiiiriiiiiiiiiiiiiiiieeeeee e 96, 162
AdODE RGB.....coeie e 163
o o {1 £ 22
F Y o] o L R €] = 163
AITange IMAGES ... 36
Auto Lighting Opltimizer.............uvviiiiiiiiiiiiiiiiiiiiiieieeeeeeee e 58
Automatic Adjustment (Gradation, Luminance) ...........ccccccoviiininennnn. 57
Automatic Dust Erasure Processing ............ceevviiiiiiveeiiiiiiiei e eeeeeeennns 86

B
Basic Adjustment Tool Palette.............ccccuviiiiiiiiiiiiiiiiiiiiieeieeeeeeeeeee 48
Batch Apply White Balance to Images (Personal White Balance)..... 127
Batch Change the File Name of Images..........cccccciiiiiiiiieiiieinnee, 132
Batch Convert/Save Images (Batch Process) .........ccccccvevveeieiinnneee. 129
Batch Process (Batch Save JPEG and TIFF Images)..........ccou....... 129
Batch Process of Multiple Images
Change File Name ... 132
Convert/Save (Batch ProCess).......cccccuuvvuuiiiiiiiiiiiiiiiiieee e 129
Personal White Balance.................ccccocoiii 127
ReCipe Data .......cocoeeiieicce e 96
TrANSTEI ... 131
Batch Settings WIiNndow...........ccooiiiiviiaes 129, 131
Batch Transfer Images ... 131
Batch Transfer Images to Image Editing Software..............ceevveeeee. 131
Before/After Comparison Display ..............eueeivveiiiiiiiiiiiiiiieeieeeeeeeeeeeeee 24
DIt NUMDET ... 162
BOOKMArK ... 40
BrightNeSS. ..o ———— 61
Cc
Change File Name............cccoo oo, 132
Change the Display ..........ccevvieiiiiiiiiiiiee e

Changing the File Name of Images in the Order in the Main
WINAOW ...ttt e e e e e e e et e e e e e e e eeeeeeeeeeeeeas

L0 0 1=To] [ Q1 1 = 1 G
Chromatic Aberration CorreCtion..........cceeeeeeeeviiieiiiiieeeeeeeeeeeeee e
Chrominance Noise Reduction.............ccooeviivieiiiiiiiiieeeeee e, 68
Click White BalanCe.........oceeeieeeeeeeeeeeee e 52,62, 137
CMYK SImUIAtion ......coveiiiiie e 163
Collection WINAOW .........oovviiiee e 102
(070] [Tl =1 [T S 001 =T 1 o] o IE R 74
(0701 (o] 01 1 7= 1 o (X 163
Color Management (Color Matching) ........cccuveeeieeiiiniiiiieece e 162
COlOr SPACE ....uuuiiiii e bbb aaaaaaaraaae 163
ICC ProfileS ... 162
Color Management (Preferences) ..o 155
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(O70] (o] g =7= 1 (8] =1 11 ] o RS SURRRR 55
Color Setting of the Monitor (Profiles)...........cccvevviiiiiiiiiiie 155
Color Setting of the Printer (Profiles) ..o 156
Color SPACE ....oovieeieeeee e, 163
AdODE RGB ... 163
APPIE RGB ... 163
Color Space Setting for Each Image ..........ccccccoviiiiiiieniiiiiiie, 90
(O70] (o4 1Y/ F=1 (1 1 = €1 = S 163
SRGB ... 163
Wide Gamut RGB...........uoiiiiiiiiee e 163
Color Space Setting for Each Image............ooccviiiiiiiiiiiiiiiiieeee e 90
Color Temperature...........oooeeieeieee 53
COolOr TONE .o 55
ColorMatch RGB........oooiiiee 163
Compositing IMagES ........uueiiiieieee e 104
L070] o1 (=11 AT 54, 61
Convert ONe IMage.......c.uueeiiiiieeeeeee e 93
Convert to JPEG or TIFF Image and Save..........ccccceevviivveeennn. 93, 129
Copy Stamp (Image Correction) ...........ceevveeiiiiiiiiiiiiee e 89
Copying and Pasting (Applying) ReCIipes.........ccccvveieeeiiiiiiiiiiiieeeeeene 97
Correct Images (Copy Stamp Function) ......................l 89
107 o] o] o] 1o T SRR 70
CuStomIzZe t00IDAN ..o 120
D
Default Color Space Setting.........c.uvveiiiiiiiiii e 155
Delete IMAgeS......uiii i —— 39
Deleting
Delete IMages .....ooovvevicii e 39
Delete the Software.........cccueeeieiiiiiii e, 160
Deleting DPP (Uninstalling) .......cooovviiiiiieeeeiiiieieee e 160
Depth cCOmMPOoSIting .....ccovveeiiiiiieiee e 115
Detailed Setting Printing (Printing with Shooting Information) .......... 123
Digital Lens OptimMiIzZer..........oooiiiiiiiiiiee e 77
Digital Lens Optimizer mark............c..oeeeeeeiiiiiiiiiiiieee e 161
Display
Before/After Comparison Display ..........cccccccc, 24

Enlarged Display (Preview Window)..............cccccc. 18
Enlarged Display (Quick Check Window) ...........ccccceeviiiiiiineeennn. 31
Multi-Function Preview.........c.cccccvvvviiii 25
Single Image Display ... 37
Synchronize Preview WiNdOW............coouiiiiiiiiiiiieeiiiieeeee e 99
Thumbnail Display (Main WindOW)...........ccuuvviiiieeiiiiiiiiieeee e 13
Thumbnail Display and Enlarged Display
(Edit Image WINdOW)........ceviiiiiiiiiiiiiieiieeeeeeeeeeee e 100
Displaying Image Properties..........ccoovuuiiiiii e 24
Displaying Shooting Information...............ccoouiieiiiiiiiiiie, 24
Distortion CorreCtion ............oviiiiiiiiiiie e 74
Downloading an Image to Your Computer ...........ccoovviiiieeieiinniiieee, 11
Downloading Images froma Camera ................cccceeeeeeeeieeen. 11
Downloading Images from a Card Reader....................oeeeeeeeeenn. 11
Do)V Y gl [oF=To [T aTe N [0 F=To =T 11
Downloading Images from a Camera...........ccccceeeeiiiiiiiiiiieeee e 11
Dual Pixel RAW OPtimizer........cccccoiiiiiiiiiiiiiiiiiiiiiiiriieeieeevveveeeeeeeeeees 111
Dust Delete Data .......coouviviieiie e 85, 86
Dust Delete/Copy Stamp Tool Palette..........cccceeeeeiiiiiiiiiieieeee 85
Dust Erasure Processing
Automatic Dust Erasure Processing ..., 85
Dust Delete/Copy Stamp Tool Palette ...........ccccvvveeeeeiiiiiiiiieen. 85
Image Correction (Copy Stamp Function) ..........ccoocciiiieiiiinnnns 89
Manual Dust Erasure (Repair Function) ...........cccccceeeiiiiiiiieennnnn. 87
DynamiC RANGe .......c.cuuiiiiiiiiiiie e 56, 65
E
Edit Image WINAOW............uuuiiiiiiiiiiiiiiiiieeiieeeeeeeeee e 100
Editing. ..o Adjusting
Enlarged Display (Preview WIindow) .........ccccvevieeeiiiiiciiiieeee e 18
EOS ULIIIY .eeeeeieee e 11
EXItING DPP ... 29
F
Filter Effect . ... 56
G
General Settings (Preferences) ..o 152
GPS MACK ... 161
Grid LINES e 22
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H
HDR (High Dynamic Range) Images...........cccccceveiiiiiiiiiieie e 108
HDR PQ MO .....coiiiiiiiie e 143
Highlight Area Warning Indicator ...........cooooiiiiiiiiie 23
Histogram Palette ... 17
HUE <.t 46, 66, 67
|
[CC PrOfileS..coiii et 162
Image INformation ... 38
Image Marks (Image Frame Information) ..........ccccccvieeeiieeiniiiinnenn. 161
Image processing (Preferences).........coocvvieeeiieiiiiciiiee e 153
Image Quality
NOiSe RedUCHION .....covviieiii e 68
J
| L [ 0= o = YRR PRPPPRPP 45,162
L
Lens Aberration CorreCtion ..........cc.uuueeiiiiiiiiiiieeeeee e 73
Lens aberration correction mark ............cccoooiioiiiiiiiiiis 161
] 1= T PP 57
Loading and Pasting (Applying) ReCipes ........ccccceeeviiiiiiiinee e 98
Luminance Noise Reduction .............oooiiiiiioiiiiiii e 68
M
Main WINAOW ... 13
Main Window (Multi-layout)............ccoooiiiiiiiii i, 20
Main Window (Thumbnail Layout) ..o 13
Manual Dust Erasure (Repair Function) ...........ccooooiiiiiiiiiiiiiiiiccnns 87
MONOCHIOME ... .o 55
Filter Effect ... 56
ToniNg effeCt........oiiii 56
Move Or CopY FOIAErS........ooiiiieiiiieeee e 40
Move Or COPY IMAGES......coiiiiiiiiiiiiiee e 39
Movies
Play BaAcCK ......ceuveiiiiiiiiiiiiiiiieeeeeeeee et 140
Save Still PhOtOS .........uuuiiiiiiiiiiiiiiiiiiiiiieieeeeeeeeeeeeee e 140
SPlit MOVIE MArK.......euviiiiiiiiiiiiiiiiiie e 161

Multi-FUNCLION PrevieW ....... ..o 25
MUIE-IAYOUL ... e e e e 20
Multiple image display mMark ..........ccccooioioioieee 161
N
Navigator Palette ... 19
NOISE REAUCHION ... 68
o
Organize IMages ....ccoooeeiieiieee ettt 39
Organizing IMagES .......uuuiiiieeie i 39
Delete IMages ..o 39
Move or Copy Folders.........ooooiiii 40
Move or Copy IMagesS......coovveieeiieeeeee 39
Register Folders as Bookmarks.............ccccoiiiiiiiiiiiiiiiniiiieeeen 40
P
Palettes
Display Method of Palettes ............cccveeiiieeiiiiiceee e, 28
Rearranging Palettes ..., 28
Perceptual ... e, 163
Peripheral lllumination Correction .............ccccueeviieiiiiiniiiiee e 74
Personal White BalancCe ...........ccuuveieiiiiiiiieeee e 127
PIcture StYIE ......e 49
Picture Style File...........ueeiieiee e 51
PN s 21
Pinned image setting mark ... 161
PreferenCes ... 152
Color Management ...........oooiiiiiiiieee e 155
General SEettiNgS .......ueeiiiiiii e 152
IMAQJE PrOCESSING ...ceiiiiiiiiiiiee ettt 153
Properties Display Settings..........oocvviiiiiiiiiii e 157
VIEW SetlNGS ..oooieiiiieeee e 156
Preview Control Panel ... 21
Preview Display Area ...t 20
Preview WINAOW .......coooi it 18
Printing
Printing a Thumbnail List (Contact Sheet Printing) ..................... 124
Printing One Sheet of Paper...........ccccoiiiiiiicec 122
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Printing with Shooting Information (Detailed Setting Printing).... 123

Printing One Sheet of Paper.............ooooviiiiiiiiiee 122
Printing with Shooting Information (Detailed Setting Printing) .......... 123
Properties Display Settings (Preferences).........ccccccciiiiiiiinns 157
Q
QUICK CheCk WINAOW.......coiiiiiiiiiiiieeeeei e 31
R
RaAtING. oo 33, 34
Rating mark........cooooiiiio e 161
LN VAT [ T T T PR 44,162
Re-Adjusting an Image .......coooiiiiiiii e 95
RECIPE .. i 96, 162
RECIPE FilE ... 96
Re-Editing an Image ... 95
Registering Folders as Bookmarks..........ccccoooooviiiiiiiiiiin e, 40
Remote ShoOotiNg ......c.ueviiiiiieee e 134
Rename WINAOW............uiiiiiiiiiiie e 132
Rendering Intent (Matching Method) ... 163
Repair (Manual Dust Erasure) .........cccccooeoeiiiiiiiiiiiiicciaes 87
Rotate IMages. ....coooiiieee e 13
S
SaAtUrAtION... .o 46, 66, 67
Save

Batch Convert/Save Images (Batch Process).........cccccceeennnnee. 129

RS T= Y PSPPI 93

SV A i ——————————————————————————————— 93
SaAVE A, 93
SaviNg RECIPES ...coeiieeiieeeeee e 97
Second WINAOWS .......cooeeiiiieeceeeeeee e, 26
SeleCt IMAGES ....vveeiiiiee e 13, 31, 100
Shadow Area Warning Indicator ............ccccoviiiiiiiiiineiieeeeeeeee 23
SharPNESS......ooooiiiii 59, 80
Shooting Information Display ...........cuueeeiiiiiiiiiiiee e 24, 38
Single Image Display ...........eeiiieeiiiiiiiiee e 37
Single Image Display of RAW and JPEG Image ..........cocccvveeeeeeennnns 37

Soft-Proof Colors FUNCHON ..........oooeeeiieee e 91
Sorting Images
CRECK MATKS ..o 33, 34
RatiNgS ..o 33, 34
] R (G = T 163
Starting Up DPP ... 10
Supported IMagesS .....oooeeeeee e 4
Synchronization (Preview Window) ...........ccoooiiiiiiiiiiiiic, 99
SYNCroNiZe IMAJES .......uueiiiiiiiiiiiie e 99
Synchronize Preview Window ...........cooooiiiiiiiiiiiiicccc, 99
System ReqUIremMeENts ...t 3
T
Thumbnail Display (Filter/Sort Function) ...........cccccvveeiiiiiiiiiiiiee e 16
Thumbnail Display (Main WINAOW) .........cceuiiiiiiiiiiiiiiieeeeiiiieeeee e 13
Change the Display.........ccooeiuiiiiiieie e 14
Thumbnail Display (Multi-layout) ............cccceeiiiiiiiiiiee e 20
Thumbnail Display and Enlarged Display (Edit Image Window) ....... 100
Thumbnail Display Ar€a ..........cooueuiiiiiiiie et 20
Thumbnail LayOut..........eeiiiiie e 13
Thumbnails Control Panel ..............uueeeiiiiiiieeeee e 15
IR T =T T 45, 162
TONE CUIMNVE ..t e e e e e e e e e e e e e e eeaa e e e eeaeeeees 162
TOoNING €ffECt... .. 56
e o] I o= 11=Y £ (- R 46
Basic Adjustment Tool Palette ..., 48
Color Adjustment Tool Palette ............coevvveieiiiiiiiiiiieeeeeeeeeeeeeeeeeee 66
Detailed Adjustment Tool Palette...........ccoovvveiiiiiciiiieee, 68
Dust Delete/Copy Stamp Tool Palette ...........................l 85
Lens Correction Tool Palette ............uveeeeiiiiiiiiiiiee e, 73
Partial Adjustment Tool Palette............cccc 81
Settings Tool Palette...........eueeiiiiiiiieeeee e 90
Tone Adjustment Tool Palette...........cccccoiiiiiis 61
Trimming/Angle Adjustment Tool Palette............cccccccciniinnnnnnns 70
o o] | o= | N 13
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Transfer
Batch Transfer Images to Image Editing Software..................... 131
Transfer an Image to Photoshop............uevvvviiiiiiieiiiiiiiieeeeeeeeee, 119
Transfer an Image to Photoshop ... 119
Trimming (CroppiNg) FANGE.......ccciiiiiiiiiiiiieee et 161
Trimming/Angle Adjustment Tool Palette.................c..cccl. 70
Trimming/Angle Adjustment Window ... 70
U
Unsaved editing content mark ............ccccooiiiiiiiiiiiiieeeeee 161
Unsharp Mask.......cooo 60
\'}
View Settings (Preferences) ... 156
Viewing Images in the Main Window (Thumbnail Layout) .................. 13
W
White BalanCe.......c..oovviiiiiiiiiiiei e 51
Click White BalanCe .......coouoveeeeeeeeeeee e 52, 62
(070] (ol gl =10 0] o 1=T =1 (0 [T 53
Personal White Balance ... 127
Wide GamUt RGB .........uuiiiiiiiiiiiiiiiiiiiieee e 163
WOTK COlOr SPACE.....ciiiiiiiiiiiiiie et 90
(070 ] (o] 1Y/ =T g F=To [T 1 4 1= o | S 155

About This Instruction Manual
It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.
Canon may change without notice the software specifications and
contents of this Instruction Manual.
The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.
Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks

Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

All other trademarks are the property of their respective owners.
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